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Conceptual overview of the .NET server

This guide describes concepts and procedures for running the Corticon Server for .NET as a web services
server, deploying Ruleflows to the Server, exposing the Ruleflows as Decision Services and testing them with
document-style SOAP requests. There are other installation, deployment and integration options available
beyond the SOAP/Web Services method described here, including Java-centric options using Java objects
and APIs. More detailed information on all available methods is contained in the Server Integration & Deployment
Guide.

For details, see the following topics:

* What is a web service on .NET server?
* What is a Decision Service on .NET server?
* What is the Corticon Server for NET?

* Whatis a .NET web services consumer?

What is a web service on .NET server?

From the business perspective: A Web Service is a software asset that automates a task and can be shared,
combined, used, and reused by different people or systems within or among organizations.

From the information systems perspective: A Web service is a software system designed to support
interoperable machine-to-machine interaction over a network. It has an interface described in a
machine-processable format (specifically WSDL). Other systems interact with the Web Service in a manner
prescribed by its description using SOAP-messages, typically conveyed using HTTP with an XML serialization
in conjunction with other Web-related standards. [From http://www.w3c.org.]
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Chapter 1: Conceptual overview of the .NET server

What is a Decision Service on .NET server?

A Decision Service automates a discrete decision-making task. It is implemented as a set of business rules
and exposed as a web service (or Java component or .NET library). By definition, the rules within a Decision
Service are complete and unambiguous; for a given set of inputs, the Decision Service addresses every logical
possibility uniquely, ensuring “decision integrity”.

A Ruleflow is built in Corticon Studio. Once deployed to the Corticon Server for .NET, it becomes a Decision
Service.

What is the Corticon Server for .NET?

Corticon Servers implement web services for business rules defined in Corticon Studios.

The Corticon Server for .NET is a high-performance, scalable and reliable system resource that manages pools
of Decision Services and executes their rules against incoming requests. The Corticon Server for .NET can be
easily configured as a web services server, which exposes the Decision Services as true web services.

Corticon Server is provided in two installation sets: Corticon Server for Java, and Corticon Server for .NET.

* The Corticon Server for deploying web services with .NET -- the product documented here -- facilitates
deployment on Windows .NET framework and Microsoft Internet Information Services (I1S) that are packaged
in the supported operating systems. The .NET server is a component part of the Corticon Server installer.
This document describes deployment features specific to Corticon Server for .NET. See the Integration and
Deployment Guide and the Data Integration Guide for more information.

* The Corticon Server for deploying web services with Java is supported on various application servers,
databases, and client web browsers. After installation on a supported Windows platform, that server
installation's deployment artifacts can be redeployed on various UNIX and Linux web service platforms.
See the Progress Software web page Progress Corticon 5.7 - Supported Platforms Matrix for more
information.

What is a .NET web services consumer?

A Web Services Consumer is a software application that makes a request to, and receives a response from,
a web service. Most modern application development environments provide native capabilities to consume
web services, as do most modern Business Process Management Systems.
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Setting up Corticon Server for .NETon IIS

Install or upgrade Corticon Server for .NET on your designated Windows machine so that you can provision
the resources for the IIS server. See "Running the Server and Web Console installer wizard" and "Preparing
Corticon .NET Server resources for an IIS server" in the Corticon Installation Guide.

Setting up IIS for .NET Server

To setup IIS to support Corticon Server for .NET 5.7.x, access the appropriate Corticon Knowledgebase article
that describes the complete configuration of .NET Framework and IIS:

e Steps to set up IIS 7.5 on Windows Server 2008 or Windows 7 for Corticon Server for .NET 5.x. These
instructions are also appropriate for Windows 10.

* Stepsto setup IIS 8.0 and 8.5 on Windows Server 2012 R1 and R2 for Corticon Server for .NET 5.x These
instructions are also appropriate for Windows Server 2016.

Corticon Server on IIS requires all the options in the IIS program feature group Common HTTP Features.

Installing Corticon .NET Server onto IIS

You always start by installing or upgrading the Corticon Server for .NET resources, and then running its installer
to push the resources to the IS location.

To install or upgrade Corticon Server for .NET into the IIS location:

1. Start Administrative Tool > IIS Manager. In the Actions panel, click Stop.
2. In [CORTICON HOME 5.7]\Server .NET\IIS,launch install.bat.
3. Accept or adjust the target location, and then press Enter.
4

. Enter A in each section of the script to accept all the files. The 5.7 resources and the deployment descriptor
files are copied. The corresponding assets are copied to the IS path /Samples/Rules Projects.

Progress Corticon: Deploying Web Services with .NET: Version 5.7.1
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Chapter 2: Setting up Corticon Server for .NETon IIS

5. Copy the brms .properties file from [CORTICON WORK DIR] root to the axis root.

6. In the IIS Manager, on the Actions panel, click Start.

For details, see the following topics:

e Testing the configuration

* Testing the installed Corticon Server for .NET

Testing the configuration

With Corticon Server for .NET installed in IS, it is a good practice to test the remote server setup to ensure it
is running and listening. At this point, no Decision Services have been deployed, so Corticon Server for .NET
is not yet ready to process transactions.

In a browser, access the following URLs (assuming that IIS is running on its default port 80):
®* http://localhost/axis/services/CorticonAdmin.asmx

®* http://localhost/axis/services/Corticon.asmx

* http://localhost/axis/services/CorticonExecute.asmx

Selecting any of these URLSs displays a web page in the following format:
Figure 1: Testing the Corticon Web Service

a'_ _'| :—g} http://localhost/axis/services/Corticon.asmx P~BCX || 2 Corticon Web Service |

File Edit View Favorites Tools Help

cotion |

The following operations are supported. For a formal definition, please review the . =

» execute

Note: If you do not see appropriate test info, choose Refresh in your browser to clear any cached references.

Testing the installed Corticon Server for .NET

With Corticon Server installed in the .NET environment, it is useful to test the installation to ensure Corticon
Server is running and listening. At this point, no Decision Services have been deployed, so Corticon Server is
not ready to process transactions. However, the Corticon Server API set contains administrative methods that
interrogate it and return status information. Several tools are provided to help you perform this test.
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Testing the installed Corticon Server for .NET

Setting the Client Type

Corticon's SOAP stack requires certain client behavior when passing payloads to an IIS server. Changing the
setting in the brms . properties file enables the appropriate client type for IIS.

com.corticon.studio.client.soap.clienttype=IIS

* Value of JAVA uses the SOAP client for a Corticon server running inside a Java container.
* Value of 113 uses the SOAP client for a Corticon server running on 1I1S
When this value is not set, the valueJAVA is assumed.

This setting is required in 1IS projects and deployments for the following functions:

* Theclients testServerAxis.bat (Java)and Corticon-Api-Remote-Test.exe (.NET) require this
property set to IIS.

* Ruletest Test Subjects use this property set to IIS to enable running the test against an IIS server. Avoid
having some Testsheets within a Ruletest connect to IIS while others are Java as running the full Ruletest
will fail.

* Packaging and deploying a project to an IIS server requires the client type set to IIS .

To revert to using these functions againist a Java server, reset the property value to JAVA or clear the property
in brms.properties, and then restart Corticon.

Testing a remote server on IIS

To test that Corticon Server deployed as a SOAP service is running correctly, all you need is a SOAP client or
the sample batch file provided and described below.

Testing the installation here assumes you have already set up IIS, and installed Corticon Server for .NET as
a Web Service. Be sure that you have created an application from the axis directory, and that it is bound to
application pools appropriately.

Because a SOAP service is listening for SOAP calls, we need a way to invoke an API method via a SOAP
message then send that message to Corticon Server using a SOAP client. In the sample code supplied in the
default installation, Corticon provides an easy way to send API calls through a SOAP message.

Sample code is provided that demonstrates a remote deployment of Corticon Server for .NET on IIS. This code
is packaged as the executable Corticon-Api-Remote-Test.exe in the Server\bin directory of your
Corticon Server for .NET installation directory.

Progress Corticon: Deploying Web Services with .NET: Version 5.7.1 11



Chapter 2: Setting up Corticon Server for .NETon IIS

When executed, it opens a Windows console and displays the APl menu, as shown below:

Figure 2: Top Portion of the .NET Server remote API console

B | CA_55x_install_dir\home\Server\Server MET\samples\bin\Corticon-Api-Remote-Test.exe

o[-l

AppSettings: Corticon Home is ..

AppSettings: Corticon Work Dir is C:n_ 5P _install dirswork_dirsServer

Setting Corticon Home to C:n_57x_install dirhome~ServersServer .NET.samples

Setting Corticon Work Dir to C:5_57x_install dirswork _dirsServer
CorticonConfiguration.setClasspath{} — Start

CorticonConfiguration.setClasspath{> java.class.path = C:\_57x_install_dir~home“Servers
Server _NETszamplesxlibsant—launcher.jar;C:5\_56x_install_dirshome:ServersServer _NET%za
mplesslibxCcExtensions . jar;C:n_57x_install dirshomesServersServer _NET-zamples:libxCcLi
cense.jar;C:~_57x_install_dirshomesServersServer _NETssamplesslib:\CecTools.jar;CGas_57x i
nstall dirshomesServersServer .NETwsamplesslibCorticonLibrary.jar;G:»_57x_install dirs
home~ServersServer .NET.samples:lib:tools.jar;

lstrLogPath C:r/_57x_install dir-work_dir-Server-logs

lstrLoglevel INFO

Axiz Servlet Location : http:~slocalhost:88

Execute Servlet (Meszage Style? - http:~-slocalhost:8Braxissservices Corticon

Execute Servlet (RPC Style> http:-/slocalhost:8B axis/servicessCorticonExecute
Admin Serwvlet http://localhost:8B axis servicesCorticonAdmin
Heartheat http:/slocalhost:8B-axis servicesCorticonHeartheat
Output Directory C:r/_ 87 _dnstall_dirswork_dir-Serversoutput

——— Current Apache Axis Location: http:~--localhost:88

-

"

The menu displayed in the Windows console is too large to fit on a single printed page, so it has been divided
into two screenshots here. In the upper portion of the Windows console, shown in the figure above, the classpath
definition process is visible. Once all classes are loaded, the Corticon Server for .NET starts up in the IS, which

is needed by our simple SOAP client class.

Figure 3: Lower Portion of the .NET Server remote API console

5 CA_S5x_install_dir\home\Server\Server NET\samples\bin\Corticon-Api-Remote-Test.exe = || == @

Transactions: ~
-1 - Exit Server Api Test

B - Change Connection Parameters

181 — Add a Decision Service (3 parameters)

182 — Add a Decision Service {6 parameters)

183 — Add a Decision Service (9 parameters)

118 - Load CcServer with .cdd file

111 — Load CcServer files from directory

112 - Reload Decision Service

113 — Reload Deciszion Service (by specific Decision Service Major Uersziond

114 — Reload Decision Service ¢(by specific Decision Service Major and Minor Uersio

115 — Remove Decision Service
116 — Remove Decizion Service (by specific Decision Service Major Uersziond
117 — Remove Decizion Service (by specific Decision Service Major and Minor Uersio

118 - Clear All Mon—Cdd Decision Services

128 — Get Decision Service Mames
121 - Get CcServer current info

138 — Execute S0AP Document Style (CorticonRequest Documentl
131 — Execute S0AP RPC Style <(CorticonRegquest String)

158 — Precompile a Ruleflow into a .eds file

151 — Precompile a Ruleflow into a Database Access optimized .eds file
188 — Switch menu to Common Functions

288 — Switch menu to Decision Service Functions

3@8 — Switch menu to Monitoring Functions

488 — Switch menu to CcServer Functions

Fnter transaction number:

4 1 3

In the lower portion of the Windows console, shown in the figure above, we see the available APl methods of
the Common Functions (the 100 series) listed by number. You can list the commands in the other series by

entering their series number:
* Enter 200 to list the Decision Service Functions command set
* Enter 300 to list the Monitoring Functions command set

* Enter 400 to list the CcServer Functions command set

12
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Testing the installed Corticon Server for .NET

* Enter 100 to again list the Common Functions command set

Note: After you enter a transaction, the result is displayed followed a restating of the current command set.
You might need to scroll back a bit to see your results.

Since we have not deployed any Ruleflows yet, we will use an administrative method to test if Corticon Server
is correctly installed as a SOAP service inside our web server. A good administrative method to call is transaction
#121, Get CcServer current info. This choice corresponds directly to the APl method getCcServerInfo ().

To try this, confirm that IIS is running, and then enter 121 in the command window. The CcServerAxisTest
class makes a call to the Corticon Server SOAP Servlet. It asks for a list of configuration parameters and returns
them to the Windows console. The results of the call are shown in the following figure:

Figure 4: .NET Server remote API console response to command 121

B | B\Prog\ServerNET\Server MET\sarmples\bin\Corticon-Api-Remote-Test.exe =0 R @

fg:er transaction number:

?xml version="1.8" encoding="UTF-8'?>
CcB8erverInfo CcLicenseFath="">
{Licenselnfo>

{LicenseProperty
{LicenseProperty
{LicenseProperty
{LicenseProperty
{LicenseProperty
{LicenseProperty
{LicenseProperty
{LicenseProperty
{LicenseProperty
{LicenseProperty
{LicenseProperty
{LicenseProperty
{LicenseProperty

name ="LICENSE_OEM_NAME' value="Evaluation' ~>

name ="LICEMSE_DATE_GRANTED" value="" />

name ="LICENSE_MAX_POOLS" value=""18" />

name ="LICEMSE_MAX_REACTORS' value="5" -

name ="LICENSE_MAX_NUMBER_OF_RULES" value="''288" />

name ="LICENSE_DEACTIUATE_DATE" value="6.1-2013" />
name ="LICENSE_DEACTIVATE_DATE_OUERRIDE" value="N0O" -3
name ="LICENSE_SINGLE_ERECUTIOM_EMNABLED" value="¥ES" />
name ="LICENSE_SINGLE_ERECUTION_DB_ACCESS_ENABLED" wvalue="NO" />
name ="LICENSE_BATCHPROCESS ING_ENABLED" value="YES" -3
name ="LICENSE_USAGE_ENFORCED" value="false" ~>

name ="LICENSE_USAGE_NAME" value="Corticon' ~>

name ="LICENSE_SERVER_IP" value="8.8_8.8" ~>

"LICENSE_INCREMENT _IF" value="8" />

'LICENSE_IF OUERRIDE" value="YES"' />
{LicenseProperty name="LICENSE_SERUER_TRANSACTIONS _TIME_PERIOD" value="6EA00A" >
{LicenseProperty name="LICENSE_SERUER_TRANSACTIONS _MAX_EXECUTIONS" value='t188" />
{LicenseProperty name="LICENSE_SERUER_TRANSACTIOM_OUERRIDE" value="YES" ~>

{sLicenselnfo>

<CDDs ~>

<NonCDDs >

{RegisteredlrackingAttributes ~>

<ServiceStartups >

{LoggingStartups >

/CcServerInfol

{LicenseProperty name=
{LicenseProperty name

Transaction completed.

4 I F

The response verifies that our Corticon Server is running correctly as a SOAP Servlet and is listening for, and
responding to, calls. At this stage in the deployment, this is all we want to verify.

Using a .NET Server installation to set up an in-process server

If you choose to manage Corticon Server for .NET in-process via your client application or via a custom container,
you are taking responsibility for many of the tasks that are normally performed by a web or application server.
But by doing it in your own code, you can optimize your environment and eliminate unneeded overhead. This
can result in much smaller footprint installations and faster performance.

Progress Corticon: Deploying Web Services with .NET: Version 5.7.1 13



Chapter 2: Setting up Corticon Server for .NETon IIS

Because Corticon Server is a set of classes, it can easily be deployed in-process in an application. When
deployed in-process, the following tasks are the responsibility of the client application:

* Management of application settings, ensuring the base set of Corticon Server classes is properly referenced.
* Lifecycle management, including server startup/shutdown
* Security (if needed)

Corticon Server can also be installed into a custom container within any application. It has a small footprint
and thus can be installed into client applications including browser-based applications, laptops and mobile
devices.

For step-by-step instructions on using the Installer to gain access to Corticon Server's core files, see “Running
the Server and Web Console installer wizard” in the Corticon Installation Guide.

Installation in-process or in a custom container involves these basic steps:

1. Place the following Corticon Server directories and their contents in a directory that is accessible by the
application container.

* /bin
e /1lib
* /conf

2. Configure the application to reference all DLL files located in the /bin directory.
3. Write code that:

* Initializes Corticon Server
* Sets the following three environment variables:

* CORTICON_ HOME - The explicit path that is the root for /bin, /1ib, and /conf.
* CORTICON WORK_DIR - The explicit path to the working directory

* CORTICON_ LICENSE - The explicit path to the CcLicense. jar file.

* Deploys the Decision Services into the Corticon Server

* Requests a decision by marshaling the data payload and then invoking the relevant Corticon Decision
Service

* Processes the response from the Decision Service.

Sample code is provided that demonstrates an in-process deployment of Corticon Server for .NET.
This code is packaged as the executable Corticon-Api-Inprocess—-Test.exe in the
[CORTICON HOME]\Server .NET\samples\bin directory.

Testing as in-process

Sample code is provided that demonstrates an in-process deployment of Corticon Server for .NET. This code
is packaged as the executable Corticon-Api-Inprocess-Test.exeinthe [CORTICON HOME]\Server
.NET\samples\bin directory.

14 Progress Corticon: Deploying Web Services with .NET: Version 5.7.1



Testing the installed Corticon Server for .NET

The API in-process test opens a Windows console and displays the APl menu, as shown below:

Figure 5: Top Portion of the .NET Server in-process API console

B | CA_55x_install_dir\home\Server\Server MET\samples\bin\Corticon-Api-Inprocess-Test.exe =2 o] |@
-

AppSettings: Corticon Home is ..

AppSettings: Corticon Work Dir is C:n_5Yx_install dirswork_dirServer

Zetting Corticon Home to C:n_57x_install dirhome~ServersServer .NET.samples

Setting Corticon Work Dir to C:5_5Px_install dirswork _dirsServer

CorticonConfiguration.setClasspath{} — Start

CorticonConfiguration.setClasspath?{) java.class.path = C:»_57x_install dir“home*Server‘Server .NET“zamples:lib“ant—launcher.jar;C:=s_57?x
_install_dirshomesServersServer _METssamplesslib\CcExtensions.jar;C:s_57%_install_dirshomesServersServer _METszamplesslibsCeLicense.jar
;0 57x_dinstall dirshomesServersServer .MNET“zamples»lib™CcTools.jar;C:%_57x_install dirshomesServersServer .NET“samples:lib“CorticonLi
brary. jar;C:~_57x_install_dirshome~ServersServer .NEIssamplesslib:tools.jar;

lstrLogPath C:/_57x install dir-work _dir-Server-logs

lstrLogLevel INFO

Starting Progress Corticon Server = 5.7_.8.8 -h7168
Progress Corticon Server sandbox location = C:/_5Px_install dir-work_dir-Server-CcServerSandbox

The menu displayed in the Windows console is too large to fit on a single printed page, so it has been divided
into two screenshots here. In the upper portion of the Windows console, shown in the figure above, the class
loading process is visible. Once all classes are loaded, Corticon Server for .NET starts up in the IIS.

Figure 6: Lower Portion of the .NET Server in-process API console

B CA 55 _install_dir\home\Server\Server MET\samples\bin\ Corticon-Api-Inprocess- Test.exe == |[

Transactions:
-1 - Exit Server Api Test

181 — Add a Decision Service (3 parameters)
182 — Add a Decision Service (6 parameters)
183 — Add a Decision Service (9 parameters)

118 — Load CcServer with .cdd file

111 — Load CcServer filez from directory

112 — BReload Decision Service

113 — Reload Decision Service (hy specific Decision Service Major Uersionl

114 — Reload Decizion Service (by specific Decizion Service Major and Minor Uersziond
115 — BRemove Decision Service

116 — Remove Decision Service (hy specific Decision Service Major Uersionl

117 — Remove Decizion Service (by specific Decizion Service Major and Minor Uerziond

118 — Clear A1l Non—Cdd Decision Services

128 — Get Decision Service MNames
121 - Get CcServer current info

138 — Execute using a JDOM Document (CorticonRequest Document>

131 — Execute uszing a XML String (CorticonRegqueszt Stringl

132 — Execute using a hard-coded set of Business Ohjects (Collection)

133 — Execute using a hard-coded set of Businessz Obhjects (Collection) <(hy specific Decision Service Major Uerziond

134 — Execute uszing a hard-coded set of Businesz Obhjects (Collection) <(by specific Decision Service Major and Minor Uersionl

135 — Execute using a hard-coded set of Business Ohjects {(Collection? ¢(hy specific execution Datel

136 — Execute using a hard-coded set of Business Ohjects (Collection? <hy specific execution Date and Decision Service Major Uersion>
137 — Execute uszing a hard-coded set of Businesz Ohbhjects (HashMap>

138 — Execute using a hard-coded set of Business Ohjects (HashMap? ¢(hy specific Decision Service Major Uersion)

13?2 — Execute using a hard-coded set of Business Ohjects (HashMap» ¢(hy specific Decision Service Major and Minor Uersionl

148 — Execute using a hard-coded set of Businessz Objects (HashMap>» c¢hy specific execution Dated

141 — Execute uszing a hard-coded set of Businesz Objects (HashMap> (hy specific execution Date and Decision Service Major Uersziond

158 — Precompile a RBuleflow into a .eds file

151 — Precompile a Ruleflow into a Database Access optimized .eds file
188 — Switch menu to Common Functions

200 — Switch menu to Decision Service Functions

308 — Switch menu to Monitoring Functions

488 — Switch menu to CcServer Functions

Enter transaction number:

In the lower portion of the Windows console, shown in the figure above, we see the available APl methods of
the Common Functions (the 100 series) listed by number. You can list the commands in the other series by
entering their series number:

* Enter 200 to list the Decision Service Functions command set
* Enter 300 to list the Monitoring Functions command set
* Enter 400 to list the CcServer Functions command set

e Enter 100 to again list the Common Functions command set
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Note: After you enter a transaction, the result is displayed followed a restating of the current command set.
You might need to scroll back a bit to see your results.

Since we have not deployed any Ruleflows yet, we will need to use an administrative method to test if Corticon
Server is loaded in-process correctly. A good administrative method to call is option #121, Get CcServer Info.
This choice corresponds directly to the corresponding APl method getCcServerInfo ().

To try this, enter 121 in the command window. The CcServerApiTest class makes a call to the Corticon
Server running in-process. It asks for a list of configuration parameters and returns them to the Windows
console. The results of the call are shown in the following figure:

Figure 7: .NET Server in-process API console response to command 121

7| C:\Program Files (x86)\Progress\Corticon 5.4\Server .NET\samples\bin\ Corticon-Api-Inprocess-Test.exe EI@
Enter transaction number: -
121

?xml version="1.8" encoding="UTF-8'7>

CcServerInfo CcLicensePath="">

{Licenselnfo’

{LicenseProperty name="LICENSE_OEM_MAME" value="Evaluation" >
{LicenseProperty name="LICENSE_DATE_GRANTED" value=""" />
{LicenseProperty name="LICENSE_MAX_FOOLE" value=""28" />
{LicenseProperty name="LICENSE_MAX_REACTORS" walue="1" ~
{LicenseProperty name="LICEMSE_MAX_MWUMBER_OF_RULES" ualue="533" el
{LicenseProperty name="LICENSE_DEACTIUATE_DATE" value="12-1-2814" >
{LicenseProperty name="LICENSE_DEACTIUATE_DATE_OUERRIDE" value="NO" />
{LicenseProperty name="LICEMSE_SINGLE_EXECUTION_ENABLED" value="YES" >
{LicenseProperty name="LICENSE_SINGLE_EXECUTION_DE_ACCESS_ENABLED" value="NO" />
{LicenseProperty name="LICEMSE_BATCHPROCESSING_ENABLED" value="NO" >
{LicenseProperty name="LICENSE_USAGE_ENFORCED" value="false' ~>
{LicenseProperty name="LICENSE_USAGE_NAME" value="Corticon" >
{LicenzeProperty name="LICENSE_SERUER_IF" value="8.8.8.8" />
{LicenseProperty name="LICENSE_INCREMENT_IFP' value="8" ~>
{LicenseProperty name="LICEMSE_IP_OUERRIDE" value="YES' />
{LicenseProperty name="LICEMSE_SERUER_TRANSACTIONS_TIME_PERIOD" value="68088" />
{LicenseProperty name="LICEMSE_SERUER_TRANSACTIONS_MAX_ERECUTIONS" value="188" />
{LicenseProperty name="LICEMSE_SERUER_TRANSACTION OUERRIDE" value="YES" >
{LicenseProperty name="LICENSE_NAMED_USERS" value="3" ~
{/Licenselnfo> e
4 nr 3

We haven't loaded any Decision Services, so Corticon Server is basically replying with an empty status message.
But the important thing is that we have verified that Corticon Server for .NET is running correctly in-process
and is listening for, and responding to, calls. At this stage in the deployment, this is all we want to verify.

There is also a sample application test for the in-process Corticon Server. This code is packaged as the
executable Corticon-Api-Example.exe inthe [CORTICON HOME]\Server .NET\samples\bin
directory.

16
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Corticon Server for .NET files and API tools

Corticon Server for deploying web services with .NET facilitates deployment on Windows .NET framework and
Microsoft Internet Information Services (11S) that are packaged in the supported operating systems. This guide
points out features for various deployment technologies and strategies.

First we'll deploy a Ruleflow to the .NET server as a Decision Service, then we'll try out consuming that Decision
Service with various manual, SOAP/XML, and JSON/RESTful techniques.

After that we'll explore some advanced topics that enable you to:

* Use Java Object Messaging (JOM) for payloads

* Compile a Decision Service into an Assembly.dll to increase performance
* Take a look at Windows Communication Framework (WCF)

But before exploring these features, you should get acquainted with some of the .NET server files and API
tools.

For details, see the following topics:

* The Corticon Server for NET home and work directories

* The Corticon Server for .NET Sandbox

Progress Corticon: Deploying Web Services with .NET: Version 5.7.1
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The Corticon Server for .NET home and work
directories

As a Corticon installation completes, it tailors two properties that define its global environment. These variables
are used throughout the product to determine the relative location of other files.

Corticon environment

The installer establishes a common environment configuration file, \bin\corticon env.bat, atthe program
installation location. That file defines the Progress Corticon runtime environment so that most scripts simply
call it to set common global environment settings, such as CORTICON HOME and CORTICON WORK DIR (and,
in some cases, simply CORTICON WORK.)

CORTICON_HOME

The explicit path of the installation home directory -- either the default location, C: \Program
Files\Progress\Corticon 5.7,orthe preferred location you specified -- is assigned to [CORTICON HOME].

CORTICON_WORK_DIR

The explicit path of the work directory -- either the default location,
C:\Users\{username}\Progress\CorticonWork 5.7, orthe preferred location you specified -- is
assigned to [CORTICON WORK DIR].However,when Corticon Server .NET is deployed to IIS, the
CORTICON WORK DIR by defaultis created in C:\inetpub\wwwroot\axis\CcServerSandbox.

Note: The Corticon Start menu provides a Corticon Command Prompt command that calls
corticon env.bat,adds several [CORTICON HOME] script paths to the PATH so that you can launch scripts
by name from several locations and then relocates the prompt to the root of the Corticon work directory.

It is a good practice to use global environment settings

Many file paths and locations are determined by the CORTICON HOME and CORTICON WORK DIR variables.
Be sureto call corticon env.bat, and then use these variables in your scripts and wrapper classes so that
they are portable to deployments that might have different install paths.

Note: While you could change these locations with the assurance that well-behaved scripts will follow your
renamed path or location, you might also encounter unexpected behaviors from any that do not. Also, issues
might arise when running update, upgrade, and uninstall utilities.

The Corticon Server for .NET Sandbox

When Corticon Server for .NET starts up, it checks for the existence of a sandbox directory. This Sandbox is
a directory structure that manages its state and deployment code.

The location of the Sandbox is set by com.corticon.ccserver.sandboxDir in your brms.properties
file located in the application folder. In a default IIS installation, the value for this is
C:\inetpub\wwwroot\axis\CcServerSandbox. This directory is created (as well as peer directories,
logs and output) during the first launch of the Corticon application on the IS server.
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Deploying a Ruleflow to the Corticon Server
for .NET

Just because Corticon Server for .NET has been installed does not mean it is ready to process transactions.
It must still be loaded with one or more Ruleflows. Once a Ruleflow has been loaded, or deployed, to the
Corticon Server we call it a Decision Service because it is a service ready and able to make decisions for any
external application or process (client) that requests the service properly.

Loading the Corticon Server with Ruleflows can be accomplished in two ways:

* Deployment Descriptor files - This is the easiest method and the one we will use in this guide because it
is also the method typically used in production web service deployments.

* .NET APIs - This method requires more knowledge of the Server for NET API set, and is not discussed in
this guide. For more information, see the topics in "Packaging and deploying Decision Services" in the
Integration and Deployment Guide.

Both methods are described more thoroughly in the Integration & Deployment Guide.

For details, see the following topics:

* Creating a Ruleflow for .NET server

* Creating and installing a .NET server Deployment Descriptor file

Progress Corticon: Deploying Web Services with .NET: Version 5.7.1
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Creating a Ruleflow for .NET server

Itis assumed you have already created a Ruleflow suitable for deployment. If you have completed the Corticon
Tutorial: Basic Rule Modeling , then you created a sample Ruleflow that is ready for deployment to the Server
for .NET. We will use that Ruleflow here.

You can take a shortcut to simply access the reference example Ruleflow, tutorial example.erf, inthe
completed tutorial located in the server's [CORTICON WORK DIR]\Samples\Rule
Projects\Tutorial\Tutorial-Done

Creating and installing a .NET server Deployment
Descriptor file

A Deployment Descriptor file tells the Corticon Server for .NET which Ruleflows to load and how to handle
transaction requests for those Ruleflows. A Deployment Descriptor file has the suffix . cdd, and we will often
simply refer to it as a . cdd file.

Important: The. cdd file “points” at the Ruleflow via a path name — it is important that this path not contain
space characters. For example, a Ruleflow stored in My Documents cannot be referenced by a Deployment
Descriptor file because its path contains a space. Even though the default storage location for your Ruleflow
files is inside a Corticon Studio installation's [CORTICON WORK DIR]\Samples\Rule
Projects\Tutorial\Tutorial-Done (which contains a space), we avoid the problem by substituting
../ ../ as arelative reference to the directory structure.

Deployment Descriptors are easily created using the Deployment Console, which is installed by the Server
installer.

Using the .NET Server's Deployment Console Decision Services

To start the Corticon Deployment Console for .NET, choose the Windows Start menu command All Programs
> Progress > Corticon 5.7 > Corticon .NET Deployment Console to launch the executable file Server
.NET\samples\bin\DeploymentConsole.exe.
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The Deployment Console is divided into two sections. Because the Deployment Console is a rather wide
window, its columns are shown as two screen captures in the following figures. The red identifiers are the
topics listed below.

Figure 8: Left Portion of Deployment Console, with Deployment Descriptor File Settings Numbered

9 Progress Corticon Deployment Console - New Deployment Descriptor EI@
Decision Services Deployment Properties
Decizion Service Maximum
Name Ruleflow Version Version Label Effective Date Expiration Date Pool Size
| |[:]| 0.0 |<unavailable> |<unavailable> | =unavailable= | 5 E
4 Tl [
[ Add Ruleflow ] [ Remowe Ruleflow ] [ Pre-compile Decision Services ] [ Save Deployment File ]
I p— A— A — A Al PN g —y PR el e sl

Figure 9: Right Portion of Deployment Console, with Deployment Descriptor File Settings Numbered

59 Progress Corticon Deployment Consele - Mew Deployment Descriptor EI@
File
Decision Services Deployment Properties
Entities Datasource Dynamic XML Messaging
Database Access Returned Configuration File Reload Style
] i [ [ JIno [auto Detect |
L] mn 3
l Add Ruleflow ] l Remowve Ruleflow ] [ Pre-compile Decision Services ] [ Save Deployment File l
[ S R S e e Tl et ket

The name of the open Deployment Descriptor file is displayed in the Deployment Console's title bar.

The File menu, circled in the top figure, enables management of Deployment Descriptor files:
* To save the current file, choose (File > Save).

* To open an existing . cdd, choose (File > Open).

* To save a .cdd under a different name, choose (File > Save As).

The marked steps below correspond to the Deployment Console columns for each line in the Deployment
Descriptor.

1. Decision Service Name - A unique identifier or label for the Decision Service. It is used when invoking the
Decision Service, either via an API call or a SOAP request message. See "Invoking Corticon Server” in the

Integration and Deployment Guide. for usage details.

2. Ruleflow - All Ruleflows listed in this section are part of this Deployment Descriptor file. Deployment

properties are specified on each Ruleflow. Each row represents one Ruleflow. Use the [ | button to navigate
to a Ruleflow file and select it for inclusion in this Deployment Descriptor file. Note that Ruleflow absolute

pathnames are shown in this section, but relative pathnames are included in the actual . cdd file.

Progress Corticon: Deploying Web Services with .NET: Version 5.7.1
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10.

1"

The term “deploy”, as we use it here, means to “inform” the Corticon Server that you intend to load the
Ruleflow and make it available as a Decision Service. It does not require actual physical movement of the
.erf file from a design-time location to a runtime location, although you may do that if you choose — just
be sure the file's path is up-to-date in the Deployment Descriptor file. But movement isn't required — you
can save your . erf file to any location in a file system, and also deploy it from the same place as long as
the running Corticon Server can access the path.

Version - the version number assigned to the Ruleflow in the Ruleflow > Properties window of Corticon
Studio. Note that this entry is editable only in Corticon Studio and not in the Deployment Console. A discussion
of how Corticon Server processes this information is found in the topics "Decision Service Versioning and
Effective Dating" of the Integration and Deployment Guide. Also see the Quick Reference Guide for a brief
description of the Ruleflow Properties window and the Rule Modeling Guide for details on using the Ruleflow
versioning feature. It is displayed in the Deployment Console simply as a convenience to the Ruleflow
deployer.

Version Label - the version label assigned to the Ruleflow in the Ruleflow > Properties window of Corticon
Studio. Note that this entry is editable only in Corticon Studio and not in the Deployment Console. See the
Quick Reference Guide for a brief description of the Ruleflow Properties window and the purpose of the
Ruleflow versioning feature.

Effective Date - The effective date assigned to the Ruleflow in the Ruleflow > Properties window of
Corticon Studio. Note that this entry is editable only in Corticon Studio and not in the Deployment Console.
A discussion of how Corticon Server processes this information is found in the topics "Decision Service
Versioning and Effective Dating” of the Integration and Deployment Guide. Also see the Quick Reference
Guide for a brief description of the Ruleflow Properties window and the purpose of the Ruleflow effective
dating feature.

Expiration Date - The expiration date assigned to the Ruleflow in the Ruleflow > Properties window of
Corticon Studio . Note that this entry is editable only in Corticon Studio and not in the Deployment Console.
A discussion of how Corticon Server processes this information is found in the topics "Decision Service
Versioning and Effective Dating" of the Integration and Deployment Guide. Also see the Quick Reference
Guide for a brief description of the Ruleflow Properties window and the purpose of the Ruleflow expiration
dating feature.

Maximum Pool Size - Specifies how many execution threads for this Decision Service will be added to
the Execution Queue. This parameter is an issue only when Allocation is turned on. If you are evaluating
Corticon, your license requires that you set the parameter to 1.See 'Multi-threading, concurrency reactors,
and server pools' in "Inside Corticon Server” section of the Integration and Deployment Guide for more
information.

Note: Minimum Pool Size, previously associated with this property, is deprecated as of version 5.5.

If you are evaluating Corticon, your license requires that you set the parameter to 1.

Database Access - Controls whether the deployed Rule Set has direct access to a database, and if so,
whether it will be read-only or read-write access.

Entities Returned - Determines whether the Corticon Server response message should include all data
used by the rules including data retrieved from a database (All Instances), or only data provided in the
request and created by the rules themselves (Incoming/New Instances).

Datasource Configuration File - The path and filename of the database access properties file (that was
typically created in Corticon Studio) to be used by Corticon Server during runtime database access. Use
the adjacent

button to navigate to a Datasource configuration file.

. Dynamic Reload - When Yes, the ServerMaintenanceThread will detect if the Ruleflow or . eds file

has been updated; if so, the Decision Service will be updated into memory and -- for any subsequent calls
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to that Decision Service -- that execution Thread will execute against the newly updated Rules. When No,
the CcServerMaintenanceThread will ignore any changes to the Ruleflow or . eds file. The changes
will not be read into memory, and all execution Threads will execute against the existing Rules that are in
memory for that Decision Service.

12 XML Messaging Style - Determines whether request messages for this Decision Service should contain

a flat (Flat) or hierarchical (Hier) payload structure. The topic "Service Contracts: Describing the call” topic
in the 'Integrating Corticon Decision Services' chapter of the Integration and Deployment Guide. provides
samples of each. If set to Auto Detect, then Corticon Server will accept either style and respond in the
same way.

The indicated buttons at the bottom of the Decision Service Deployment Properties section provide the following
functions:

(A) Add Ruleflow - Creates a new line in the Decision Service Deployment Properties list. There is no limit
to the number of Ruleflows that can be included in a single Deployment Descriptor file.

(B) Remove Ruleflow - Removes the selected row in the Decision Service Deployment Properties list.

(C) Pre-compile Decision Services - Compiles the Decision Service before deployment, and then puts
the . eds file (which contains the compiled executable code) at the location you specify. (By default, Corticon
Server does not compile Ruleflows until they are deployed to Corticon Server. Here, you choose to
pre-compile Ruleflows in advance of deployment.) The . cdd file will contain reference to the . eds instead
of the usual . erf file. Be aware that setting the EDC properties will optimize the Decision Service for EDC.

(D) Save Deployment File - Saves the . cdd file. (Same as the menu File > Save command.)

Installing the Deployment Descriptor file on .NET server

Once Corticon Server for .NET has been installed and deployed on 1IS, the following sequence occurs:

1. 1IS server starts.

2. Corticon Server for .NET starts as a web service in IIS.
3.
4

Corticon Server looks for Deployment Descriptor files in the <IISRoot>\axis\cdd directory.

. Corticon Server for .NET loads into memory the Ruleflow(s) referenced by the Deployment Descriptor files,

and creates Reactors for each according to their minimum pool size settings. At this stage, we say that the
Ruleflows have become Decision Services because they are now callable by external applications and
clients.

In order for the Corticon Server for .NET to find Deployment Descriptor files when it looks in step 3, we must
ensure that the . cdd files are stored in the default location, the [CORTICON WORK_DIR] \cdd directory. When
creating . cdd files, save them to this directory so they become accessible to the deployed Corticon Server for
.NET.

Note: This location is configurable, but be aware that Deployment Descriptor files usually contain paths relative
to where they were created; as such, copying or moving them to a different location can make the file behave
incorrectly. For more information, see the topic "Packaging and deploying Decision Services" in the Integration
and Deployment Guide.

Now, when the startup sequence reaches step 3 above, the server knows where all Ruleflows are located
because . cdd files contain their pathnames.
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Hot re-deploying .NET server Deployment Descriptor files and
Ruleflows

Changes to a Deployment Descriptor file or any of the Ruleflows it references do not require restarting 11S. A
maintenance thread in the Corticon Server for .NET watches for additions, deletions, and changes and updates
appropriately. A Ruleflow can be modified in Studio even while it is also simultaneously deployed as a Decision
Service and involved in a transaction - Server can be configured to update the Decision Service dynamically

for the very next transaction.

Having selected No for the Dynamic Reload setting earlier, our tutorial example Decision Service will
not update automatically when the .erf file is changed. To enable this automatic refresh, choose Yes for the
Dynamic Reload setting.

Note: When using .NET Server on IIS 7.5 and EDC-enabled Decision Services, redeploying a Decision Service
to use a different database is not supported. To change the database or a deployed Decision Service you need
to; undeploy the Decision Service, restart the .NET server (or server host), and then redeploy the Decision
Service with the preferred database.

24
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Consuming a Decision Service on .NET
server

So far:

P D

. We have installed Corticon Server for .NET files onto a workstation or server .

We have configured Corticon Server for .NET as a web service onto IIS.
We have used the Deployment Console to generate a Deployment Descriptor file for our sample Ruleflow.

We have installed the Deployment Descriptor file in the location where Corticon Server for .NET looks when
it starts.

Now we are ready to consume this Decision Service by sending a real XML/SOAP “request” message and
inspecting the “response” message it returns.

For details, see the following topics:

Integrating and testing a Decision Service on .NET server

Path 1: Using Corticon Studio as a SOAP client to consume a Decision Service
Path 2: Using bundled C# sample code to consume a Decision Service

Path 3: Using SOAP client to consume a Decision Service

Path 4: Using JSON/RESTHful client to consume a Decision Service on .NET server
Path 5: Using bundled JSON sample code to consume a Decision Service

Limits of the .NET server default evaluation license

Troubleshooting .NET server

Progress Corticon: Deploying Web Services with .NET: Version 5.7.1
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Integrating and testing a Decision Service on .NET
server

In order to use a Decision Service in a process or application, it is necessary to understand the Decision
Service's service contract, also known as its interface. A service contract describes in precise terms the kind
of input a Decision Service is expecting, and the kind of output it returns following processing. In other words,
a service contract describes how to integrate with a Decision Service.

When an external process or application sends a request message to a Decision Service that complies with
its service contract, the Decision Service receives the request, processes the included data, and sends a
response message. When a Decision Service is used in this manner, we say that the external application or
process has successfully “consumed” the Decision Service.

This guide describes four paths for consuming a Decision Service:

* Path1

Use Progress Corticon as a SOAP client to send and receive SOAP messages to a Decision Service
running on a remote Corticon Server - This is different from testing Ruleflows in Corticon “locally.” This
path is the easiest method to use and requires the least amount of technical knowledge to successfully
complete. If you have already installed Corticon Studio, then you have all necessary components to complete
this path. If not but want to follow this path, we recommend completing the Corticon Installation Guide and
the Corticon Studio Tutorial: Basic Rule Modeling before continuing on this path.

* Path2

Manually integrate and test a Decision Service - In this path, we will use bundled sample code (a command
file) to send a request message built in Corticon Studio's Tester, and display the results. This path requires
more technical knowledge and confidence to complete, but illustrates some aspects of the software which
may be interesting to a more technical audience. If you have already installed Studio, then you have all
necessary components to complete this path. If not but want to follow this path, we recommend completing
the Corticon Installation Guide and the Corticon Studio Tutorial: Basic Rule Modeling before continuing on
this path.

e Path3

Use a commercially available SOAP client to integrate with and test a Decision Service - This SOAP
client will read a web-services-standard service contract, generate a request message from it, send it to the
Corticon Server and display the response message.

* Path4

Use JSON/RESTful client to consume a Decision Service on .NET server - This RESTful client will read
a web-services-standard service contract (discussed below), generate a request message from it, send it
to the Corticon Server and display the response message.

* Path5

Use bundled JSON/REST sample code to consume a Decision Service - A sample of .NET code is
provided that you can tailor to execute Decision Services with REST/JSON.

26
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Path 1: Using Corticon Studio as a SOAP client to
consume a Decision Service

In this path, we will use Corticon Studio as a SOAP client to execute Decision Services running on a remote
Corticon Server.

Configuring Studio to send a SOAP Message to IIS

Corticon Studio is configured by default to query a localhost web server on port 8850. Because we are
using IS, we’ll change the port used by Studio to send Test messages.

Note: Instead of 1ocalhost, you can use the static IP or DNS-resolvable name of the host -- a good idea as
it emulates actual deployment.

To configure the port:

1. Navigate to the directory [CORTICON WORK DIR].

2. Edit the file brms.properties in that location.

Note: If you specified a preferred name and location of the override properties file in Studio preferences,
edit that file as it the one that will be the last loaded.

3. Add the following line to the file so that you are pointing to your IS server port:
com.corticon.deployment.soapbindingurl 2=http://localhost:80/axis
4. Add the following line to the file to adjust the SOAP stack to be compliant with the IIS server:

com.corticon.studio.client.soap.clienttype=I1IS
5. Save the edited file.
6. Restart Corticon Studio.

The edited value is added to the list of Remote Servers.

Creating a .NET server test in Corticon Studio

Important: Even though we are using Corticon Studio to test, we will use its remote testing feature, which
executes a Decision Service running on a Corticon Server (remotely), not a Ruleflow open in Corticon Studio
(locally). To keep this distinction clear, we are not going to open tutorial example.erf in Corticon Studio
— it is not necessary since we are really testing the Decision Service sample Cargo .NET sample deployed
and running as an application on a Microsoft IS server.

1. In Corticon Studio, create a new Ruletest by choosing the menu command File > New > Ruletest.
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o DN

i Create New Ruletest u&@

Ruletest

Create a new Ruletest

Enter or select the parent folder:

Tutorial/Tutorial-Done

a L Tutorial
= Tutorial-Done

File name:  myTutorialRuletest

< Back Next > ——r

.

Select the parent folder for the new Ruletest.
Enter a file name for the new Ruletest.
Click Next to open the Select Test Subject panel.

Click the Run against Server tab to open its panel, as shown:
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Select Test Subject ﬁ
Run against Server

Server URL:

http://localhost 8850/ /axis -
Credentials are required if authentication is enabled on Server:

Username: Password:

Decision Services:

Marne Major Minor Effective Start Date Effective Stop Date i
AllocateTrade 1 14 L
Candidates 1 14 [
Cargo 0 16

Freight 1 9

Freight 2 1 -
4 m 3

Opticnal Overrides

Major Version: 0

Minaor Version: 16

Effective Target Date: | [/ / - | Time 0 | 0 5 0 —|AM =

[ OK ] l Cancel l

e

6. For the Server URL, enter a URL; for example, an IIS server installed (and running) on its default port
installed on the same machine as the Studio: http://localhost:80/axis. Yourentry is validated when
you click Refresh, and persisted in your Studio. Once you have persisted URLs, click on the right side of
the Server URL area to open the dropdown menu to make your selection.

Note: Only a few Server URLs are persisted this way. If you have a larger list that you want to edit, see
"Specifying server URLs for access to test subjects"” in the Quick Reference Guide.

Click Refresh to populate the list of deployed Decision Services on that server.

7. Click on an appropriate Decision Service for this Ruletest:

Mame Major Minor Effective Start Date Effective Stop Date
AllocateTrade 1 14

Candidates 1 14

Cargo 1 ]

ProcessOrder L\\T 1 10

8. You can click OK at this point if you do not want to apply the optional overrides.

9. When the selected Decision Service was deployed with a date range defined, it is active from the effective
date through the expiration date. You can apply overrides to change the test Decision Service's version or
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to simulate the Ruletest's call as occurring at a specific point in time. Specify your preferred values -- major
version + effective target date -- as illustrated:
Opticnal Overrides

Major Version: 1

Minor Version: |

Effective Target Date: |01/29/2016 ~ Time: 0 5| 0 5 1 = |AM = ||Clear

10. Click OK. The dialog closes. The details of the remote server and Decision Service specifications are
displayed at the top of the Testsheet:

untitled 1

http://localhost:80/axisTname= Cargo,major version=1 effective target date=01,/29/16 12:00:01 AM

11. Run the Ruletest.

The test executes against the specified Decision Service on the selected .NET web server using the overrides
you entered.

Executing the remote .NET server test

Execute the Test by selecting Ruletest > Testsheet > Run Test from the Corticon Studio menubar or ﬂ
from the toolbar.

We should see an Output pane similar to the following:

Figure 10: Response from Remote Decision Service

[a Cargo.ecaore Vc *sample_testert &2

untitled_1
http://localhost:80/axisttutorial_example
Input Output

a (=] Cargo[1] a4 =] Cargo [1]
== container == container [oversize]
== manifestNumber == manifestMumber [6254]
[=| needsRefrigeratiol = needsRefrigeration
= volume [350] = volume [350]
j=| weight [150000] = weight [150000]

4 I 3

|Z] Rule Statements | L Rule Messages 2

Severity Message

Info Cargo with velume > 30 cubic meters must be packaged in an oversize container.

The Output pane of the Testsheet shown above displays the response message returned by the Corticon
Server. This confirms that our Decision Service has processed the data contained in the request and sent back
a response containing new data (the container attribute and the message).

30 Progress Corticon: Deploying Web Services with .NET: Version 5.7.1



Path 2: Using bundled C# sample code to consume a Decision Service

Path 2: Using bundled C# sample code to consume a
Decision Service

To use this path, you should have solid .NET programming skills and familiarity with the .NET Framework SDK
environment. This guide does not provide in-depth explanations of working within the .NET environment.

Sample web service client code is provided in [CORTICON HOME] Server
.NET\samples\webservice-client. This sample includes the following files:

* Cargo FlightPlan.wsdl - WSDL generated by the Deployment Console
* CargoDecisionProxy ASPNET.cs - C# web service proxy generated by wsdl.exe
* CallCargoService.cs - C# code demonstrating how to call the web service

* GenProxy.bat - Code to generate the decision service proxy from the WSDL

Creating the WSDL and proxy files

The WSDL and the proxy files are created as follows:

1. If your .NET Server and Studio are colocated, you have the Tutorial Ruleflow in the server's
[CORTICON WORK DIR]\Samples\Rule Projects\Tutorial\Tutorial-Done.

If your .NET Server and Studio are on separate machines, copy and stage that file so that it can be accessed
on the .NET server machine.

2. Launch the Deployment Console on the Corticon Server .NET machine by choosing the Start menu command
All Programs > Progress > Corticon 5.7 > Corticon .NET Deployment Console

3. Click the ... button to the right of the Ruleflow on the one empty line listed, and the locate the
tutorial example.erf file.
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4. In the lower section, click the Type dropdown, and then choose WSDL.

The window should now look like this:
Figure 11: Creating a new WSDL using the Deployment Console

%1 Progress Corticon Deployment Censole - New Deployment Descriptor EI@
File
Decizion Services Deployment Properties
Decision Service Maximum
MName Ruleflow Wersion Version Label Effective Date Expiration Date Pool Size Database Access
tutorial_example | 1T utorial-Doneutorial_example.erf | 016 ‘<unavallahle> |<unava|\ab|e> ‘(unavallah\a | 5
l | 1|

Add Ruleflow Remove Ruleflow Pre-compile Decizion Services Save Deployment File |

Service Contract Specification

Decizion Service Level (™~ Vocabulary Level @+

“Wocabulary File: |C:\jT»Unstall,dirWorkﬁdir\?erver\?amples\qula Praojectz T utorial*T utorial-Done'Cargo.ecore

Type:
#ML Messaging Style: |Flat
SOAP Server URL: | http: Mocalkhost88504x1 s

Generate Service Contracts ‘

| Ready

5. Click Generate Service Contracts to save the service contract file, which is named Cargo Cargo.wsdl.
It may be convenient to generate this file into a separate directory. Here, we use directory
[CORTICON WORK DIR].

Note: To generate a web service proxy, you need wsdl .exe. When you run wsdl .exe
Cargo_Cargo.wsdl,thefile CargoDecisionService. csis created. Place thatfile in the NET Server's
[CORTICON HOME]. Refer to the GenProxy.bat file located at [CORTICON HOME \Server
.NET\samples\wcf-client for the WSDL options, typically /namespace: and /out:.

6. Write C# client code to call the web service. We provide a sample in CallCargoService.cs, which sets
values of attributes used in the rules.

7. Compile CargoDecisionService.cs and CallCargoService.cs usingthe csc *.cs command.
Generally, the compile process needs to occur in your .NET Framework root directory, so you may need to
move both C# files to that directory prior to compilation. In our case, the .NET Framework is installed at
C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319

This generates an executable file named CallCargoService-webservice.exe. Store the file in your
[CORTICON WORK DIR].

8. If you have not already done so, deploy the tutorial example Decision Service to Corticon Server for
.NET on IIS. Follow the instructions for Creating and Installing a Deployment Descriptor File.
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9. Run CallCargoService-webservice.exe to execute the call to Corticon Server. You will see the
following output:

Figure 12: Invoking Corticon Server for .NET via C# Sample Code

Calling service tutorial_example

workDocumentsType

Cargo weighing > 20000 kilos and a volume <= 30 cubic meters
must be packaged in a heavyweight container.

Path 3: Using SOAP client to consume a Decision
Service

Web Services Service Contracts

Many commercial SOAP and web services development tools have the ability to import an XSD or WSDL
service contract and generate a compliant request message directly from it. This path assumes you have
access to such a tool and want to use it to consume a Decision Service.

The Corticon Deployment Console can produce both XSD and WSDL documents. The Server Integration &
Deployment Guide contains much more information about these documents, including detailed descriptions of
their structure and elements. However, if you have chosen this path, we assume you are already familiar enough
with service contracts to be able to use them correctly once generated.

Web services messaging styles

There are also two types of messaging styles commonly used in web services:

1. RPC-style, which is a simpler, less-capable messaging style generally used to send smaller messages and
receive single variable answers. Some of the administrative methods in Corticon Server's SOAP API| use
RPC-style messaging.

2. Document-style, which is more complex, but allows for richer content, both in request and response
messages. Corticon Server for NET’s execute method is most commonly invoked through document-style
messaging because of its ability to work with a complex data payload.

Important: Any SOAP client or SOAP-capable application used to consume a Decision Service deployed to
the Corticon Server must use document-style messaging. See the Integration & Deployment Guide for complete
details on proper structure of a compliant request message.

Creating a service contract using the Deployment Console

Launch the Deployment Console as before and follow the instructions below to generate a service contract.
All Deployment Console options below are also described in more detail in the Server Integration & Deployment
Guide.
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1. Decision Service Level / Vocabulary Level. These radio buttons determine whether one service contract
is generated per listed Ruleflow, or if a single “master” service contract is generated from the entire
Vocabulary. A Decision Service-level service contract is usable only for a specific Decision Service, whereas
a Vocabulary-level service contract can be used for all Decision Services that were built using that Vocabulary.
Choose the option that is most compatible with your SOAP tool.

2. Vocabulary File. If generating a Vocabulary-level service contract, enter the Vocabulary file name (. ecore)
here. If generating a Decision Service-level contract, this field is read-only and shows the Vocabulary
associated with the currently highlighted Ruleflow row above.

3. Type. This is the service contract type: WSDL, XML Schema, or Java classes. Note, no output is produced
when Java classes is selected because there is no standard method for describing service contracts in the
Java world.

4. Output directory. The location where you want the Deployment Console to save this service contract.

5. XML Messaging Style. Enabled only for Vocabulary-level service contracts. Describes the message style,
flat or hierarchical, in which the WSDL will be structured.

6. SOAP Server URL. URL for the SOAP node that is bound to the Corticon Server. Enabled for WSDL service
contracts only. The default URLs http://localhost:8850/axis/services/Corticon and
https://localhost:8851/axis/services/Corticon make a Decision Service available to the default Corticon
Server installation performed earlier. Note: These URLs can be changed and additional URLs can be added
to the drop-down list.

7. Generate Service Contracts. Use this button to generate either the WSDL or XML Schema service contracts
into the output directory. If you select Decision Service-level contracts, one service contract per Ruleflow
listed at top will be created. If you select Vocabulary-level, only one contract is created per Vocabulary file.

Creating a request message for a decision service

Once your SOAP development tool has imported the WSDL or XSD service contract, it should be able to
generate an instance of a request message that complies with the service contract. It should also provide you
with a way of entering sample data to be included in the request message when it is sent to the Decision
Service.

Important:

Most commercial SOAP development tools accurately read service contracts generated by the Deployment
Console, ensuring well-formed request messages are composed.

One occasional problem, however, involves the Decision Service Name, which was entered in field 3 of the
Deployment Console's Deployment Descriptor section. Even though all service contracts list
decisionServiceName as a mandatory element, many SOAP tools do not automatically insert the Decision
Service Name attribute into the request message's decisionServiceName element. Be sure to check this
before sending the request message. If the request message is sent without a decisionServiceName, the
Corticon Server will not know which Decision Service is being requested, and will return an error message.

Enter all required data into the request message. The tutorial example.erf example requires the following

data:

Vocabulary Term Possible Values
Cargo.weight A number less than or equal to 200, 000
Cargo.volume Any real number
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Path 4: Using JSON/RESTful client to consume a Decision Service on .NET server

Sending a request message to the server

Make sure IIS is running and your Deployment Descriptor file is installed in the correct location as described
earlier. Now, use your SOAP tool to send the request message to the Server for .NET.

Your SOAP tool should display the response from the Server for .NET. Are the results what you expected? If
not, or if the response contains an error, proceed to the Troubleshooting section of this guide.

Path 4: Using JSON/RESTful client to consume a
Decision Service on .NET server

You can create Corticon requests in JavaScript Object Notation (JSON), a text format that you can use as an
alternative to XML. A JSON RESTHful interface is one that follows the REST architectural style and uses JSON
as its data representation format. Specifically, a standardized JSONObject with name-value pairs of
“Objects” :<JSONArray>can be passed in to Corticon Server's ICcServer.execute (..) to process the
request and return a JSON-formatted reply.

Running the sample JSON Request on .NET server

A Corticon Server installation provides a JSON sample (similar to the SOAP . xm1 sample) and a test script
that runs the sample.

Note: JSON datatypes require double-quotes only on String values. As JSON does not have a date datatype,
Corticon treats time values as Strings. When the other datatypes -- Booleans and numbers -- are in quotes,

Corticon interprets the datatype from its Vocabulary properties and removes the quotes. Output will conform
to the JSON syntax.

The sample, located at [CORTICON WORK DIR]\Samples\Rule
Projects\OrderProcessing\OrderProcessingPayload. json, is as follows:

{"Objects": [

"total": null,
"shipped": null,

"item": [
{
"product": "Ball",
"price": "10.000000",
"quantity": "20",
"subtotal": null,
" metadata": {
"#id": "Item id 7",
"#type": HItem"
}
b
{
"product": "Racket",
"price": "20.000000",
"quantityll: "l",
"subtotal": null,
" metadata": {
"#id": "Item id 8",
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"#type": "Item"
}
b
{
"product": "Wrist Band",
"price": "5.250000",
"quantityll: "2",
"subtotal": null,
" metadata": {
"#id": "Item id 9",
"#type": "Item"
}
}
1,
"shippedOn": null,
" metadata": {
"#id": "Order id 1",
"#type": "Order"
by
"dueDate": "1/1/2008",
"note": null
br
{
"total": null,
"shipped": null,
"item": [
{
"product": "Pencil",
"price": "1.000000",
"quantity": "10",
"subtotal": null,
" metadata": {
"#id": "Item id 10",
"#type": llItem"
}
by
{
"product": "Notebook",
"price": "3.000000",
"quantityll: "2",
"subtotal": null,
" metadata": {
"#id": "Item id 11",
"#type": "Ttem"
}
b
{
"product": "Eraser",
"price": "2.000000",
"quantity": "l",
"subtotal": null,
" metadata": {
"#id": "Item id 12",
"#type": n Item"
}
}
1,
"shippedOn": null,
" metadata": {
"#id": "Order id 2",
"#type": "Order"
b
"dueDate": "1/1/2009",
"note": null

To run the JSON sample:
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1. Start Corticon Server .NET.
2. Open a command prompt window at [CORTICON HOME]\Server .NET\samples\bin.

3. Launch Corticon-Api-Rest-Test.exe. The command transaction list is displayed:

Transactions:
-1 - Exit REST API Test

142 - Execute JSON REST request

143 - Execute JSON REST request (by specific Decision Service Major Version)

144 - Execute JSON REST request (by specific Decision Service Major and Minor Version)
145 - Execute JSON REST request (by specific execution Date)

146 - Execute JSON REST request (by specific execution Date and Decision Service Major
Version)

Enter transaction number

4. Enter 142.
5. When prompted for Input JSON File Path, enter the path to the sample:

C:\Users\{user}\Progress\CorticonWork 5.7\Samples\Rule
Projects\OrderProcessing\OrderProcessingPayload. json

6. When prompted for Input Decision Service Name, enter (or copy) the name of the Decision Service that
is the sample's target:

ProcessOrder
The request is processed, and its output is placed at [CORTICON WORK_DIR] \output with a name formatted

as OutputCRString {epochTime}.jsonwhere {epochTime} isthe number of seconds that have elapsed
since 1/1/1970. The input file is also placed there. The output for the sample is as follows:

{

"Messages": {
"Message": [

{
"entityReference": "Order id 2",
"text": "The total for the Order is 18.000000.",
"severity": "Info",
" metadata": {"#type": "#RuleMessage"}

by

{
"entityReference": "Order id 1",
"text": "The total for the Order is 230.500000.",
"severity": "Info",
" metadata": {"#type": "#RuleMessage"}

s

{
"entityReference": "Order id 1",
"text": "This Order was shipped late. Ship date 12/1/2008",
"severity": "Warning",
" metadata": {"#type": "#RuleMessage"}

by

{
"entityReference": "Order id 2",
"text": "This Order was shipped on time. Ship date 12/1/2008",
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"severity": "Info",
" metadata": {"#type": "#RuleMessage"}
}
1,
" metadata": {"#type": "#RuleMessages"},
"version": "1.10"
b
"Objects": [
{
"total": 230.5,
"shipped": true,
"item": [
{
"product": "Ball",
"price": "10.000000",
"quantity": "20",
" metadata": {
"#type": llItem",
"#id": "Item id 7"
by
"subtotal": 200
br
{
"product": "Racket",
"price": "20.000000",
"quantity": "1",
" metadata": {
"#type": llItem",
"#id": "Item id 8"
b
"subtotal": 20
by
{
"product": "Wrist Band",
"price": "5.250000",
"quantity": 11211,
" metadata": {
"#type": " Item",
"#id": "Item id 9"
by
"subtotal": 10.5
}
1,
"shippedOn": "12/1/2008",
" metadata": {
"#type": "Order",
"#id": "Order id 1"
1y
"dueDate": "1/1/2008",
"note": "This Order was shipped late"
by
{
"total": 18,
"shipped": true,
"item": [
{
"product": "Pencil",
"price": "1.000000",
"quantity": "10",
" metadata": {
"#type": llItem",
"#id": "Item id 10"
by
"subtotal": 10
by
{
"product": "Notebook",
"price": "3.000000",
"quantityll: "2",
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" metadata": {
"#type": "Item",
"#id": "Item id 11"

by

"subtotal": 6

"product": "Eraser",

"price": "2.000000",

"quantity": "1",

" metadata": {
"#type": llItem",
"#id": "Item id 12"

s
"subtotal": 2
}
I
"shippedOn": "12/1/2008",
" metadata": {
"#type": "Order",
"#id": "Order id 2"
by
"dueDate": "1/1/2009",
"note": "This Order was shipped on time"

"name": "ProcessOrder"

Path 5: Using bundled JSON sample code to consume
a Decision Service

Sample C# code that you can use to create a C# project, or create your own sample client to execute a JSON
request using the REST API supported by Corticon .NET.

Note: To use this path, you should have solid .NET and C# programming skill, as well as familiarity with the
.NET Framework SDK environment.

This sample includes the following files:

* CorticonServerRestTest.cs - Commented C# code to help you create a .NET REST client to execute
against the REST Service in Corticon Server for .NET running in 11S 7.5.

* Json60 - Reference DLL for JSON used in CorticonserverRestTest.cs for .Net framework.

* app.config - Application configuration file to load assembily files for a C# project.

Limits of the .NET server default evaluation license

The license included in the default Corticon Server for .NET installation has preset limits on some Corticon
Server and Decision Service parameters. These limits are:
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* Number of Decision Services — Up to five Decision Services may be deployed at any given time. This
means the sum total of all Decision Services loaded via . cdd files, Web Console, or APIs cannot exceed
five.

* Pool Size — No Decision Service may have a maximum pool size setting of greater than five. Pool size is
measured on a Decision Service-by-Decision Service basis, so you may have up to 5 Decision Services
deployed (compliant with the Decision Service limitation above), each with up to five Reactors in its pool,
without violating the default license restrictions.

* Number of Rules — All rules in all deployed Ruleflows (in other words, all deployed Decision Services) must
not exceed 200. A rule generally consists of a single Condition/Action Column or a single Action row in
Column 0. Filter expressions do not count because they only modify other rules.

The Corticon Server log can capture errors and exceptions caused by expired or “under-strength” licenses. These
log messages are detailed in the Using Corticon Server logs section of the Integration and Deployment Guide.

If you are a Progress Corticon customer, you should have access to an unlimited license that will lift these
restrictions. If you are an evaluator, and discover that these limitations are preventing or inhibiting your evaluation,
contact Progress Corticon support or your Progress representative for a license with expanded capabilities.

Troubleshooting .NET server

When you have problems on the .NET Server, refer to "Using Corticon Server logs" and "Troubleshooting"
topics in the Integration and Deployment Guide.
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Using .NET Business Objects as payload for
Decision Services

Introduction

Microsoft .NET Classes provide applications with reusable, portable code. Classes are logical sections of an
application. For instance, the call to a database and retrieval of table data is part of a data class. These classes
can be used in other sections of the application, or can be used it in an entirely different software design.

Class properties that allow other areas of code to interface with the class are usually created with get and
set keywords.

Corticon Server for NET can communicate with .NET classes through a Java Object Messaging (JOM) interface.
This topic shows how a client program can instantiate a .NET class and then use that object instance to
communicate with Corticon Server for .NET. In other words, this enables Corticon Server for .NET to natively
bind to the application’s .NET class definitions during rules execution.

Note: For information about setting up Java object mapping and inheritance, see ‘Java object mapping'in the
Integration and Deployment Guide.

To use the JOM interface from any C# client application, it is necessary to create Java stubs that match the
C# object model. These stubs will enable Corticon Studio Vocabulary Editor to import the class metadata for
mapping purposes; in other words, to pull in the names of the get and set methods needed. The stubs are
also used to generate import statements in the compiled rules.

At deployment time, the Corticon Server for .NET will dynamically transform the Rule asset from Java byte
code into .NET Common Intermediate Language (CIL), the object-oriented assembly language for .NET runtime
environments. When this is done, the Java code stub references inside the stub library (a . jar file) are
translated into references to the actual C# class file library (a . d11 file). Finally, the translated Rule asset (CIL)
will directly call get/set methods on the C# object during Rule asset execution.
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IKVM.NET

To create Java Stubs from .NET class files, Corticon supplies an open source utility, IKVM.NET, which is an
essential component of the Corticon Server for .NET runtime architecture enabling it to seamlessly operate in
.NET environments. IKVM.NET is included in your Corticon Server for .NET installation.

Note: For more information about IKVM.NET, see their web site, http://www.ikvm.net.

IKVM.NET is an implementation of Java for Mono and the Microsoft .NET Framework. It includes the following
components:

* A Java Virtual Machine implemented in .NET
* A .NET implementation of the Java class libraries

* Tools that enable Java and .NET interoperability

Running the sample Java Object Messaging (JOM) client application

The sample JOM Client uses C# objects to communicate with Corticon Server for .NET (in- process) via the
object messaging interface.

Run this sample program by launching [CORTICON HOME]\Server .NET\samples\bin\JomClient.exe)
When the application launches, the window lets you enter parameter values for executing this decision service:
* Name

* Age

* Is this person a skydiver?

a- Corticon .NET Object Test | = || @ |[wE3m]
Mame Bob
Age 25
| Skydiver
Risk  Low Risk

Enter values, and the click Execute to see the decision.

You might wonder how this application was created and how it works. Let’s examine its building blocks. When
you understand the solution architecture, it will be easy to create your own examples and solutions.

Examining the sample

The sample JomClient .exe uses a Rulesheet. Open [CORTICON NET WORK DIR]\Samples\Rule
Projects\JOM\Rules\jom.RiskRating.ers:
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773 jom_RiskRating.ers &7 =) jom.ecore =

Conditions 0 il 2 3 -
a  Applicant.isSkydiver T - F ]
b Applicant.age - <35 == 35
c
d =
Actions 4 LI} k[
Post Message(s) CA i i
A Applicant.riskRating 'High Risk' 'Low Risk' 'Mediurm Risk’
B
C -
Overrides
| Rule Statements &2 LA Rule Messages =
Ref |ID Post Alias Text -
1 Info Applicant Applicants who skydive are High Risk
2 Info Applicant Applicants under 35 are Low Risk
3 Info Applicant Applicants 35 and over who don't skydive are Medium Risk
4 n I

Open the Vocabulary [CORTICON NET WORK DIR]\Samples\Rule Projects\JOM\Vocab\jom.ecore.
When your vocabulary has Java Object Mapping established, the Applicant Entity shows that it is bound to
the Java Package cli.CorticonLibrary, and its Java Class name refers to the C_Applicant class.

= jom Basic Properties ®
= Applicant Property Mame Property Value
Entity Mame Applicant

Inherits From

»

lava Object Properties

Java Package cli.CorticonLibrary
Java Class Name C_Applicant

Each Attribute within the Entity refers to a Java Object Get Method and a Java Object Set Method method,

as shown:
4 L jom ) Basic Properties ®
4 = Applicant Property Mame Property Value
=] .age ) Attribute Name age
By isSkydiver pata Type Integer
= name Mandatory Mo
= riskRatir‘lg: Mode Base
i e Jaya Object Properties &
Java Object Get Method get_Inthge
Java Object Set Method set_IntAge

Java Object Field Name

So how do we getthe CorticonLibrary that contains these Java classes exposed in the Corticon Vocabulary
editor? Let's see.
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Invoking Corticon Server for .NET

JomClient.exe is written in C#. Logic that invokes the in-process server is located for the sample at
[CORTICON NET HOME]\samples\api-client\jom\JomClientForm.cs, as shown:

private woid btnExecute_Click(ocbject sender, Eventirgs e)

1
C_Applicant 1C_Applicant = new C_Applicant();
1C_Applicant.S5trName = txtName.Text;
1C_Applicant.IntAge = Convert.ToInt32(txtAge.Text);
1C_Applicant.Blnskydiver = chkSkydiver.Checked;

Arraylist 1listObjects = new Arraylist();
1listObjects.add(1C_Applicant);

iICcServer.execute(DECISION _SERIVCE_NAME, llistObjects);

C_Applicant 1C_ApplicantReturned = (C_Applicant)llistObjects.get(@);

txtRating.Text = 1C_ApplicantReturned.StrRiskRating;

Running the sample JOM application

Now when you launch JoMClient . exe, Corticon Server for .NET will try to deploy the JOM Decision Service.
As described above, the JOM .ecore has already imported the Java Stub Class Metadata. That's important
for the next step. The JOM Client will first compile the [CORTICON NET WORK DIR]\samples\Rule
Projects\JOM\jom.erf into a deployable .eds file. For the compilation to be successful, the
CorticonLibrary.jar mustbe in the \1ib directory. During deployment of the . eds file, the IKVM loader
will convert the Java byte code into CLI and also load the C# class definitions in CorticonLibrary.dll,
effectively allowing JomClent . exe to use C# object instances to communicate with Corticon Server for .NET.

Preparing the C# Class files

We want the client program to instantiate C_Applicant, and then use that object instance to communicate
with Corticon Server for .NET. First we’ll need a class file we are using in our application to expose all data
objects. For that, we willuse [CORTICON NET HOME]\samples\api-client\jom\CorticonLibrary.cs,
as shown:

44
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lising System;
ramespace Corticonlibrary

I
i

public class © Applicant

{

g striase;
isHarried;
AtAge
blnSkydiver;
strRickRating;
; strState;

public String Striase
i
gtt { return striase; }
set { striame = value; }
3
public Intil Intage
{
get { return intAge; ¥
set { intAge = value; }
3
public Booliens: BlnSkydiver
{
get { return blaSkydiver; }
set { blaSkydivér = value; }
3}
public String StrRiskRating
i
gt { return ;rrni‘hkﬂnlir&u; 1
set { strRiskRating = value; }
}
public Zoolean IsMarried
{
get { return isMarcied; }
set { isMarried = velue; }

Note: Having a namespace in the CorticonLibrary.cs file is mandatory.

Compile the CorticonLibrary.cs to create the CorticonLibrary.dl11l. To use the JOM interface from
any C# client, it is necessary to create Java stubs that match your C# object model. For the JOM Client example,
we used Visual Studio to compile the C# class C_ Applicant into CorticonLibrary.dll.

Save CorticonLibrary.dll toboth [CORTICON NET HOME]\samples\gen stubs\ and
[CORTICON NET HOME]\samples\bin\

Generating the Java Stubs

We can generate the Java stub file from CorticonLibrary.d11 using the utility script
[CORTICON NET HOME]\samples\gen stubs\GenStubs.bat:

Kk kk Kk kK

@echo off

SET IKVM HOME=..\bin

SET INPUT DLL NAME=CorticonLibrary.dll

SET OUTPUT JAR NAME=CorticonLibrary.jar

ATTRIB -R %OUTPUT JAR NAMES%

"%IKVM_HOME%\ikvmstub.exe" %INPUT_DLL_NAME%

ECHO Successfully completed: C# types in $INPUT DLL NAME% were converted into stubs in
$OUTPUT_JAR_NAME%.

Pause
* Kk Kk ok ok kK

The GenStubs.bat utility will generate the JAR CorticonLibrary.jar.
Add CorticonLibrary.dll to [CORTICON NET HOME]\samples\bin\

Add CorticonLibrary.jar to [CORTICON NET HOME]\samples\lib\.
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Note:

About putting the CorticonlLibrary. jar in the samples\1lib directory - It is important to understand
where to locate the JAR file, especially when you are outside of Corticon installation directories. The JAR that
the Corticon .NET Configuration (inside CorticonShared.d11l) directs IKVM to load all JAR files that are
located in the [CORTICON NET HOME]\1lib directory. In the case of the JomClient.exe, the
JomClient.exe defines [CORTICON NET HOME] equal to [CORTICON NET HOME]\samples. Where is
this done? Each .NET Application has a . exe.config file where the user defines their Corticon Home and
Work directories. For example bin\JomClient.exe has a JomClient.exe.config. Within that file is the
following section:

<configuration>
<appSettings>
<add key="CORTICON HOME" value=".." />
<add key="CORTICON WORK DIR"
value="C:\Users\{user}\Progress\CorticonWork 5.7 .Net"/>
</appSettings>
</configuration>

That defines CORTICON HOME as located up one directory level from where the . exe is currently located.
Typically, the resultis C:\Program Files\Progress\Corticon 5.7 .Net\Server .NET\samples
Then the CorticonConfiguration changes CORTICON HOME by adding “\1ib” which locates it in that
directory where it loads all the JARs.

Supported .NET datatypes for Attributes

Corticon Attributes support .NET Business Objects with nullable datatypes. Using a trailing ? character converts
the Datatype into a Nullable Datatype of the same type.

Boolean
bool
Boolean?
bool?

Byte
byte
Byte?
byte?

Char
char
Char?
char?

DateTime
DateTime?

Decimal
decimal
Decimal?
decimal?

Double
double
Double?
double?

float
float?

Intlo
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Intl6?

Int32
Int32?

Int64
Into64d?
int
int?

long
long?

short
short?

String
String?

Supported .NET datatypes for Associations

Corticon Associations support .NET Business Objects.

C# Association Datatypes:

System.Collections.ArrayList
System.Collections.IList

<Business Object Name>[] (Array of Business Objects)

IKVM Open JDK Datatypes:

java.util.ArrayList
java.util.Vector
java.util.HashSet
java.util.Collection
Java.util.List
java.util.Set

All datatypes that are supported are demonstrated in the CorticonLibrary.cs file under the Objecta and
ObjectB objects.

Using GenStubs.bat for your .NET Business Objects

To generate stubs:

1.

Compile the .NET Business Objectsin .cs or . vb to create a .d11 file. For example, use myDotNetBo.cs
or myDotNetBo.vb. to compile myDotNetBo.d11.

. Copy the .NET Business Object .d11 to the [CORTICON NET HOME]\samples\gen stubs\ directory.

3. Locate a text editor at [CORTICON NET HOME]\samples\gen stubs\ to edit GenStubs.bat.

Modify the following two properties to match the . d11 name and the . jar name, as shown here for
myDotNetBo.

SET INPUT DLL NAME= myDotNetBo.dll
SET OUTPUT JAR NAME= myDotNetBo.jar

Save the file under an appropriate name(such as GenStubs_MyBo.bat).

Run your GenStubs script file to generate the Java stub JAR file.
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Note: The first time you do this, you get a warning message about not finding myDotNetBo. jar:

B Administrator: C\Windows\system32\cmd.exe EI@

-

File not found — myDotNetBo.jar
Successfully completed: CH#f types in myDotMetBo.dll were converted into stubs in myDotNetBo._jar.

Press any key to continue . . . _

Ignore this -- it is trying to delete it first, but it isn’t there.

The Java stub JAR file you created is saved at [CORTICON NET HOME]\samples\gen stubs\.

7. Copy your JAR (for example, myDotNetBo.jar)to [CORTICON NET HOME]\samples\lib.

8. Verify the creation of the JAR file. The following example illustrates a stub class in the
CorticonLibrary.jar through a Java Decompiler:

Il WinZip Pro - CorticonLibrary.jar (== = |

File Actions View Jobs Options Help

D 5 0 e R & 8 9 9 @ &

New Oben Favorites Add ll-:x'tra.ct Mail Encrypt View CheckOut  Wizard  View Style
Address  cli\CorticonLibrany, -8 EEE ]
Folders X & Encrypted Mame Type ’ Modified Size Ratio Packed
I [CorticonLibraryjar] 2 Object.class CLASS File 5/30/2013 12:23 PM 804 42% 468

bl _ %] Objecth.class CLASS File 5/30/201312:23 PM 3257 63% 1,209
. CorticonLibrary || C_Applicent.class CLASS File 5/30/201312:23 PM 704 36% 451

s Java DecompilerIObjectB.class \ =B X

File  Edit Navigate Search Help
EA- A | @
wz92ed \ =

BEE cli.CorticonLibrary ObjectB.class I
[J] ObjectB

Al

package cli.CorticonLibrary;
®|import cli.System.DateTime;
public class ObjectB extends Object
{
public final natiwve boolean get_Bool Proceased():
public final native woid set_Bool Processed(boolean paramB

public final native DateTime get_Datetime Processed():

Me‘[hod stu bg public final native woid set_Datetime Processed(DateTlime p

Selected 1 file, 804 4 public final native Decimal get_Decimal Class(}; EOO0

public final native woid set_Decimal Class(Decimal paramDe

public final native long get_Long Prim{);

public final native woid set_Long Prim{long paramlong);

public final native String get_String Class();

9. Open the Vocabulary in Corticon Studio, and then chose the menu command Vocabulary > Java Object
Messaging > Import Java Class Metadata, as shown:
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%] Add Domain
Add Entity
v Add Attribute

Add Asscciation

Database Access 3

Java Object Messaging 4 Import Java Class Metadata
Clear Java Class Metadata

Set to Read Only

V5 Show Vocabulary Details

10. Browse to [CORTICON NET HOME]\samples\gen stubs\:

. "

Im ort Java Class Metadata = || = || B2
p _22 |

Java Metadata Sources
Select JARs or classes to be imported, plus any JARs your classes depend on. 1

Import From Directory @

Select the directory that contains JARSs or dasses to be imported.

. IS

»

4 | samples
» | api-client
J bin
E J conf 3
. gen stubs
s lib

o wef-client

J webservice-client

@:} 4| U} C Cancel

Folder: gen stubs

o) [ ]

1. Select the JAR that you want imported into Corticon Studio, as well as mscorlib. jar thatis also in the
gen stubs directory. The mscorlib. jar needs to also be selected because the . jar file that was
created through the gen stubs process depends on the classes inside the mscorlib.jar.

Progress Corticon: Deploying Web Services with .NET: Version 5.7.1

49



Chapter 6: Using .NET Business Objects as payload for Decision Services

Import Java Class Metadata

Java Metadata Sources

Select JARs or classes to be imported, plus any JARs your classes depend on.

From directory: C\Program Files\Progress\Corticon 5.7\Server -

o 5|

[E (= gen stubs [[] = CorticonLibrary.dll
[7] =] CorticonLibrary.jar
= GenStubs.bat

= GenStubs_M)rBo.bat
] mscorlib.jar

[7] 5 myDotMNetBo.dll

%] myDotMetBo.jar

SelectAll | | DeselectAll |

—
S
P
=
A
W

Finish Cancel

12 Select the packages that are associated with the Java Stub Classes that were created in the gen stubs
process. In our example, the CorticonLibrary. jar contains classes underthe cl1i.CorticonLibrary

package.

Note: As noted earlier, Business Objects require a defined Namespace. If there is no defined Namespace,
the Java Stub Classes will have a default package of only c11i. That would force you to choose the c1i
checkbox, and import ALL the Java Class Metadatainthe CorticonLibrary.jarandthemscorlib. jar,

an unwarranted scope.
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Import Java Class Metadata

Java Package Selection
Select the packages to be imported.

4 =] cli
¥|<=) CorticonLibrary
) Systermn
] Microsoft

Select Al | | Deselect Al

3 ]
'\?,' < Back lext =

Finish | |

Cancel |

13. After import is complete, verify that the Java Object Getter/Setter Methods have been assigned to each

of the Attributes and Associations.

4 L jom ] Basic Properties
a4 5 Applicant Property Name
= lage . Attribute Name

B isSkydiver g Type

B4 name Mandatory

= riskRating  Mode
Java Object Properties

Java Object Get Method
Java Object Set Method
Java Object Field Name

Property Value
riskRating
String

No

Base

get_StrRiskRating
set_StrRiskRating

»

»

The Vocabulary tries to SmartMatch the Vocabulary Attribute and Association Names to match a Getter/Setter
name in the imported Java Metadata. The SmartMatch looks for an appropriate Getter/Setter Method that
begins with get or set as in get<AttributeName> or get <AttributeName>. If this occurs, the

Getter/Setter value inside the Vocabulary is colored light grey, indicating that it was determined through a

SmartMatch lookup.

However, in the example above, SmartMatch is unable to match the Getter/Setter with Attribute ri skRating
because the appropriate Java Class Method does not conform to the SmartMatch algorithm:

* Vocabulary Attribute: riskRating

* Smart Match looks for: getRiskRating () or get RiskRating ()

* Actual Java Method: get StrRiskRating()

14. Since the SmartMatch failed to locate an appropriate Getter/Setter, you need to select the appropriate
Getter/Setter Method from the drop-down for that Attribute or Association. Since the user defined their own
mappings, the Getter/Setter method value is colored black (as illustrated).

15. After deploying the rules to IIS server, ensure that the Business Objects are picked up by copying:

Progress Corticon: Deploying Web Services with .NET: Version 5.7.1

51



Chapter 6: Using .NET Business Objects as payload for Decision Services

* myDotNetBo.jar to C:\inetpub\wwwroot\axis\lib

* myDotNetBo.dlltoC:\inetpub\wwwroot\axis\bin

16. When the package has been created, it will look something like this:

£ Java Class Metadata Import

Selact the packages contaning the Java classes fo which this Vocabulary will be mapped

‘Y com

#1-[] cortican

* L|rm:r{:sur!

=N Skydiverlava

-] com

' microsoft
] sal

= ch [-\r

Testing outside IS

If you are testing your work outside of 1IS, such as in a Visual Studio Environment, you to perform some extra
tasks:

1. Copy the myDotNetB0O.d11 to a location where it can be referenced. If running in 1IS and the axis
application has been deployed, the .d11 needs to be moved to the c: \inetpub\wwwroot\axis\bin
directory.

2. Copy the myDotNetBo. jar into the running application's [CORTICON NET HOME]\1lib directory.

The JAR is needed during compilation of the Ruleflow (. erf) into an Enterprise Decision Service (. eds) file.
The compilation step depends on the . jar file being in the [CORTICON NET HOME]\1lib directory.

Note: About putting the JAR in the \1ib directory when Business Objects are used in IIS

The CorticonConfiguration looks for CORTICON HOME\1lib. With IIS, CORTICON HOME could be defined
or overridden in the web.config file under [IIS]\axis.

Parameters can be set in Corticon in the <appSettings> section. Note there are no CORTICON HOME or
CORTICON WORK DIR settings. That means that the “current directory” is the CORTICON HOME and
CORTICON WORK DIR. ForlIS, put the JAR file in C:\inetpub\wwwroot\axis\1lib.
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Compiling a Decision Service into an
Assembly DLL

Compiling a Decision Service's . eds file into an Assembly.d11 file provides a marked improvement in
performance over IKVM dynamically converting . class files during deployment by compiling the . class files
inside the . eds file into an Assembly.d11 that contains Corticon Data Objects (CDOs), listeners and Rules.
The resulting Assembly.d11 is added to the .eds file. When the . eds file is deployed, the Corticon Server
looks for an Assembly.d11, and when it finds one, it gets the information it needs from the Assembly.d11
instead of from the .class files inside the . eds file.

Creating an Assembly.dll

A Corticon Server for .NET installation includes a script, CompileAssembly.bat, located in the .NET Server's
home directory that creates an Assembly.d11. The script's inputs require the location of the .eds file you want
to compile, and -- if you have Business Objects -- the name of the reference . jar to create for the Business
Objects.

To compile a Decision Service into an Assembly.d11:
1. Generate an . eds file. (You could use Transaction Id; 150/151 to Precompile a RuleFlow into an . eds file.)

2. If you have Business Objects, you need to generate stubs (as described in Using .NET Business Objects
as payload for Decision Services on page 41) into a . jar file that will be incorporated into your .d11.

3. Edit the script CompileAssembly.bat located at [CORTICON HOME]\samples\compile assembly
as follows:

®* SET INPUT EDS FILE NAME="<path of the input .eds file>"

®* SET REFERENCE JAR FILE NAME="<path of the reference .jar created by GenStubs>"
(or empty)
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4. Save the edited file.
5. Open a Command Prompt to the location [CORTICON HOME]\samples\compile assembly

6. Run the CompileAssembly script.

When the script successfully completes, the . eds file has embedded its Assembly.d11 .
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8

Extensions in .NET execution environments

Introduction

You might want custom extensions to Corticon in .NET execution environments. For example, you might need
to apply a complex mathematical formula in your business rules, or you need to retrieve data from an external
web service. When creating your extensions, you'd like to re-use existing .NET code, or create new code that
you want to program in .NET, your preferred development environment.

How can the capabilities of Corticon be extended?

In Corticon, there are two ways of extending Corticon functionality:

* Extended operators - Used when defining conditions and actions in a Rulesheet. While Corticon has a
large built-in set of operators, you can expand that set by adding custom operators. Operators can operate
on individual attributes, collections or sequences.

* Service callouts - Callouts can be used in a Ruleflow to retrieve, modify, or store data that is being processed
by the rules. The most common use is to access data in a database or external web service. For example,
if your Ruleflow needs to look up an applicant's credit rating, the service callout can have a step in the
Ruleflow processing that calls out to a trusted real time ratings provider, and then adds the response back
into the decision processing.

Note: Writing extensions for Corticon is described in detail in the the Corticon Extensions Guide which
discusses the sample extension projects included in your Studio installation that shows you how extensions
are built. As the Java and .NET languages are very similar,you can easily see how .NET extensions function.
This topic shows how to use extended operators in Corticon for IIS.
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.NET compatibility with Corticon

Corticon at its core is developed in Java. However, it offers a Corticon Server for .NET rules execution
component, which facilitates deployment on Windows .NET framework and Microsoft Internet Information
Services (IIS) that are packaged in supported Windows operating systems. At deployment time, the Corticon
Server for .NET dynamically transforms the deployed Ruleflow asset from Java byte code into .NET Common
Intermediate Language (CIL), the object-oriented assembly language for .NET runtime environments. In other
words, Corticon Server will natively execute your business rules in .NET without needing a Java Runtime
Environment (JRE) by leveraging the .NET framework.

Corticon supplies an open source utility, IKVM.NET (included in the Corticon Server for .NET installation) that
is an essential component of the Corticon Server for .NET runtime architecture enabling it to seamlessly operate
in .NET environments.

IKVM.NET is an implementation of Java for Mono and the Microsoft .NET Framework. It includes the following
components:

* A Java Virtual Machine implemented in .NET
* A .NET implementation of the Java class libraries
* Tools that enable Java and .NET interoperability

In writing the Corticon extensions for .NET, you use these IVKM.NET utilities to successfully integrate your
.NET extensions with Corticon.

Creating and Integrating .NET extensions

The steps required to create and integrate your .NET extensions with Corticon, are, in summary:

1. Write your .NET class file(s) containing the C# code that you require in your extension(s) — such as transform
data, calculate a value, or retrieve data through a REST callout.

2. Compile a Java stub file from your .NET DLL using an IVKM utility.

3. Create your Corticon extension skeleton using minimal Java code. Insert the call(s) to your C#
methods/functions from your .NET DLL using the Java stub file.

4. Export your extension as a JAR file.

5. In the Corticon rules project properties, reference your extension JAR file, and your .NET class compiled
to a Java stub file.

6. Copy your extension DLL to the Corticon Server for .NET.
7. Deploy your Ruleflow to a Corticon Server for .NET instance.
8. Test your deployed decision service in Corticon Studio Tester.

Let's go through all these steps using a sample extended operator.

1. WRITE YOUR .NET CLASS FILE(S)

First, create a C# Class project in Microsoft Visual Studio. In this e xample, the Corticon extension will determine,
based on an arbitrary string of characters, whether your string has an odd or even number of characters.

Example:
Value 1 = “What’s up!” = 10 characters
Value 2 = Value 1 assessed by our extended operator = Even

Below is the C# code that we have used in our class file.

using System;
namespace CorticonFunctions
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public class DataHandler

{
public String IsOddOrEven (String astrInput)

{
String variableValue = null;
switch ((astrInput.Length) % 2)
{
case 0:
variableValue = "Even";
break;
default:
variableValue = "0dd";
break;
}
return variableValue;
}

Build your project in Visual Studio. That provides you with a DLL. Name it CorticonFunctions.dll.

Ao = | #z CoticonFunction: DtsHandler

wqen) R

public LaiddirEven( astrlnput)
T

warfablevalue = mull;
wwitch ([astrInput.Lesgth) X 2}

blavalue = "Even”;

wariablevalue =

Eewak;

returs warfablevalue;

W% -

Output

Shew cutpes from: | Build - - A
T I
ctions -> C:iUiariihverles\Documanti\Visusl Stuic 2003\ProjectiiCorticonfuncticna\Corticonfunctioni\CortlconfunctionabinJety
di 1 succeeded, @ falled, @ we-to-date, @ skipped sesssssses

2. COMPILE A JAVA STUB FILE

You can only integrate Java components with Corticon Studio to build your rules. To leverage your C# class
file in the extension which you need to integrate with Corticon to create a Java stub file — a wrapper around
your C# class file that contains only the metadata or references to our original compiled class file.

To create our Java stub from your CorticonFunctions.dll, you will use an IVKM utility packaged in the Corticon
Server for .NET installation to generate Java JAR files from .NET DLLs. The JAR files generated by IKVM
contain Java classes and interfaces that correspond to .NET classes, but don't contain any real code. They
contain just enough to satisfy the Studio Java compiler, and allow it to type check the Java application. In your
Corticon installation, navigate to:

[CORTICON HOME]\Corticon 5.7\Server .NET\samples\gen stubs
There you find the GenStubs . bat file.

Copy it and rename the copy to, for example, GenStubs CorticonFunctions.bat
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Open GenStubs_CorticonFunctions.bat with a text editor of your choice. Edit the INPUT DLL NAME
to point to your generated CorticonFunctions.dll and the OUTPUT JAR NAME to
CorticonStubFunctions.jar and save.

[ GenStubs_CorticonFunctions bat E1 ‘

Pecho off
SET IKVM_HCIME= ..\bin

SET INPUT DLL NAME="C:\Users\hverlee\Documents\Visual Studio
2015\Pro'ects\CorticonFunctionS\CortiCoanpctiogs\CorticonFugctionS\bin\Debuq\CorticonFugctions.dll"
SET OUTPUT_JAR NAME=CorticonStubFunctilons.jar

ATTRIB -R

;: " : \ikvmstub.exe" -out:

Zi ECHO Successfully completed: C# types in %$INI I were converted into stubs in
pause

Save the file, and then double-click it to launch and execute the compilation process:

As a result, a new stub file gets created in the same folder, CorticonStubFunctions.jar:

Mame Date modified Type Size
05/2018 16:29 Executable Jar File 1 KB
e DE/02/2018 06&:07 Windows Batch File KB
%] GenStubs_CorticonFunctions.bat 18,/05/2018 18:33 Windows Batch File KB
| mscorlib.jar D8/02/2018 D607 Executable Jar File 071 KB

Now you can work on your Corticon Extension.

3. CREATE YOUR CORTICON EXTENSION
Corticon Studio can create the Java extension that you will include (or reference) and use in your .NET code.

To use your C# code, you need to reference the CorticonStubFunctions.jar so you get access to the
methods in your C# class.

Corticon Studio's Eclipse environment provides a Java perspective as well as the Corticon Designer perspective.
You need to get your Corticon Studio into the Java perspective.
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Window Help
Mew Window

Hide Toolbar

Show View

Perspective
Mavigation

Preferences

Open Perspective

Custornize Perspective...

Save Perspective As...
Reset Perspective...
Close Perspective

Close All Perspectives

» Q Corticon Designer

Other...
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Chose the Java perspective:

fi1 Open Perspective O x

% Corticon Designer (default)

?ﬁﬁi Debug

[air Git

%J Java

E::;,J_Iava Browsing

‘Egj_lava Type Hierarchy

(5] Planning

«J=Plug-in Development
{5 Resource

% SWM Repository Exploring
EDTeam Synchronizing

Choose File > New > Java Project. Enter the Project Name CorticonExtensionsNew. Click Finish.
Right-click on the project name, and then choose Properties. Choose Java Build Path, and then click its
Libraries tab. Click Add External JARs. Locate and add your CorticonStubFunctions.jar

i Properties for CorticonExtensionshlew O X
type filter text Java Build Path
> Resource — & B\ Libraries |
Builders 2 Source Projects loraries % Order and Export Y . .
our Corticon Stub File (JAR
Java Build Path JARs and class folders on the build path: ( )
» Java Code ?tyle > (ma CorticonStubFunctions.jar - C:\Progress\Corticon 5.7\S
> Java Compiler » @ CORTICON_HOME/Studio/lib/CcExtensionAPLar - C:\F
' jwa:d'tfl . > @i JRE System Library [Studio] B bl Futecnal 14F
avadoc Location A A
oo st \ Add Variable... The Corticon Extensions JAR
Run/Debug Settings e required to build extensions
» Task Repository
Add Class Folder...
| Add External Class Folder... |
(e Your Studio’s Java Run Time (JRE)
Remove
Migrate JAR File...
< >
Apply
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Now let’s write our extension code based on what is described in the extensions guide.
package com.progress.corticon.extensions;

import com.corticon.services.extensions.Description;

import com.corticon.services.extensions.ICcStringExtension;
import com.corticon.services.extensions.OperatorFolder;
import com.corticon.services.extensions.TopLevelFolder;

import cli.CorticonFunctions.*;

@TopLevelFolder ("Extended Operators")
public class StringExtensions implements ICcStringExtension{

@OperatorFolder (lang = { "en" }, values = { "String" })
@Description(lang = { "en" }, values =
{ "returns string value even or odd based on the"
+ "number of characters in an input string." })

public static String IsOddOrEven (String strInput) ({
String strRetVal = null;

try{

DataHandler dh = new DataHandler () ;
strRetvVal = dh.IsOddOrEven (strInput);
} catch (Exception e) {

strRetvVal = strlInput + " error";

}

return strRetVal;

In this code, notice:

import cli.CorticonFunctions.*;

You need to do an import (USING in C#) to reference the .NET package where you developed your code. Since
Java compilers can only compile applications that use Java API's, not .NET API's, we have to trick the Java
compiler into believing that there is really a Java package named cli.Corticonfunctions.

tryd
DataHandler dh = new DataHandler () :
strRetVal = dh.Is0ddOrEven (strinput) ;
catch (Exception =) {
strRetVal = striInput + " _error”;

retorn strEetVal;

The DataHandler class and its embedded method Is0OddOrEven pass in an input value, run the C# code
against that input value, and return an output value.

The amount of Java code is modest. This is a simple .NET example where your .NET code might encompass
hundreds of program lines, and contain references to other .NET assemblies. The Corticon extension simply
invokes your code and is unaware of its complexity. That is all the coding needed.

4. EXPORT YOUR EXTENSION AS JAR FILE

You want to export this Java project as executable Java code. Right-click on the project, choose Export, and
then Java > JAR file. Click Next, and select the export destination (such as [CORTICON HOME]\Corticon
5.7\addons\CorticonFunctions.jar). Click FINISH.
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JAR File Specification

Define which rescurces should be exported into the JAR.

1
Select the resources to export:
@] L=} CorticonExtensionshlew = .classpath
=l .project
] ext.jardesc
Export generated class files and resources
[] Export all output folders for checked projects
[[] Export Java source files and resources
[] Export refactorings for checked projects. Select refactorings...
Select the export destination:
JAR file: | C\Progress'\ Corticon 5. 7\addens\CorticonFunctions.jar w Browse...

Options:
Compress the contents of the JAR file
[[] Add directory entries

[[] Ovenwrite existing files without warning

'/?j' < Back Mext = Cancel

Your JAR is now available to be used in your rule project.

5. REFERENCE YOUR JAR FILES IN THE CORTICON RULE PROJECT PROPERTIES

You want a Corticon rule project to be aware of the new Extended Operator you just created by referencing
the created JARs so they can be packaged with the compiled Decision Services on deployment to the Corticon
Server for .NET.

Change to the Corticon perspective by clicking Corticon Designer:

Q Corticon Designer %" lava

Choose File > New > Rule Project. Enter the Project Name Corticon Extensions .NET. Click Finish.
Right-click on the rule project, choose Properties, and then choose Corticon Extensions.

Click Add to include CorticonFunctions.jar and CorticonStubFunctions.jar in the project.
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type filter text Corticon Extensions = -

Resource

Builders Add extended operator and service call-out JAR files used in this project.

e T . The selected JAR files will be packaged inside EDS files produced by the Package and Deploy wizard.

Project References =| C\Progress\Corticon 5.Tvaddons\CorticonFunctions jar Add

Run/Debug Settings =| C\Progress\Corticon 5.7\ 5erver NET\sarmples\gen stubs\Corticon5tubFunctions.jar

Task Repository Add From Project...
Remove
Select All
Clear All

Click OK.

Look at the Operators tab. Your extension is listed under Strings:
o® Rule Operat... 2

v % Extended Operators
v [ String
@ 1s0ddOrEven )

It is available for rule modeling.

Create a simple Vocabulary, an Entity with two String attributes:
(2] Rule Vocabulary =3 = 92 0
v (L] Extension
w =] Emtity
== strAtrribute]
=] strattributed

Then a Rulesheet with a single action:
E “Determine Odd or Even.ers 73

Conditions

=l -]

Actions

Post Message(s)
A Entity. strAttributel = Entity. stritributel lsOddOrEven
B
C

And a Ruleflow that will carry your Rulesheet to deployment.
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6. COPY YOUR EXTENSION DLL TO THE CORTICON SERVER FOR .NET

You cannot test these rules in Corticon Studio's tester against a local Rulesheet. Corticon Studio is a Java
application, and does not know how to execute your C# natively. Only Corticon server for .NET can do this as
it contains the required peripheral IKVM open source utilities to do this. And you cannot pre-compile the Ruleflow
into a Decision Service for the same reasons.

You need to deploy your Ruleflow to the Corticon Server for .NET, and then make it aware of your C# code
compiled to a DLL. The Ruleflow will be deployed to Corticon Server running inside the Application Server IIS,
so IS needs to know where to find the executable .NET code contained in your new extended operator.

Copy your CorticonFunctions.dll toC:\inetpub\wwwroot\axis\bin\ (the default IIS location on
Windows).

7. DEPLOY YOUR RULEFLOW TO A CORTICON SERVER FOR .NET INSTANCE

Create a text file named Determine 0dd or Even.cdd. Adjust the path appropriately.

<?xml version="1.0" encoding="UTF-8"?>
<cdd soap_server binding url="http://localhost:8850/axis">
<decisionservice>
<name>Determine Odd or Even</name>
<path>../Rule Projects/Determine 0Odd or Even/
Rules/Determine Odd or Even.erf</path>
<options/>
</decisionservice>
</cdd>

Save the CDD file, and then copy it to the IIS cdd folder, C: \inetpub\wwwroot\axis\cdd. You do not
need to restart IIS.

8. TEST YOUR DEPLOYED DECISION SERVICE IN CORTICON STUDIO TESTER

Edit your Studio's properties files, [WORK_DIR] \brms.properties to add the line
com.corticon.studio.client.soap.clienttype=I1S. Save all your files, and then restart Studio.

Open your Ruletest file, and then choose Ruletest >Testsheet > Change Test Subject. Choose the Run
against Server tab, and then enter the IIS server URL for Corticon, typically http://localhost:80/axis.
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Click Refresh, and then choose Determine 0dd or Even in the list:

{7 Select Test Subject x|

Run in Studio  Run against Server

Server URL:
I http://localhost:80/ axis j

Credentials are required if authentication is enabled on Server

Uszername: I Pazsword:

Decision Services:

Refresh |

Mame Major Minar Effective Start Date | Effective Stop Date | »
Airfreight 0

AllocateTrade 14

AllocateTradels 14

Candidates 14

Candidatesl5 14

Determine Odd or Even 0 ;I

2
1
1
1
1
1
- Opticnal Overrides
Major Version: I
Minor Version: I

EffectiveTargetDate:l I/ jTime: IU jlﬂ jlﬂ ﬁIAM j Clearl

(0] I Cancel |

Click OK. Run the Ruletest.
"’e *Determine Odd or Even.ert i3
untitled_1

http://localhost:80/axis’name=Determine Odd or Even,major version=1,minor version=0

Input
v =] Entity [1] v =] Entity [1]
=] strAttributel [What's Up!] =] strAttributel [What's Up!]
= strAttribute =] strAttribute2 [Even]
v (=] Entity [2] v (=] Entity [2]
=] strAttributel [Hello and goodbye] =] strAttributel [Hello and goodbye]
= strattribute? #=| strAttribute2 [Odd]

Your .NET extension behaves as expected when tested on an IIS server from Corticon Studio.
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Support for Windows Communication
Framework (WCF)

To use this approach, you should have solid .NET programming skills and familiarity with the .NET WCF

Framework. This guide does not provide in-depth explanations of working within the .NET WCF environment.

Sample web service client code is provided in [CORTICON HOME]Server .NET\samples\wcf-client.
This sample includes the following files:

* Cargo FlightPlan.wsdl - WSDL generated by the Deployment Console

* CargoDecisionProxy WCF.cs - C# web service proxy generated by svcutil.exe
* CallCargoService.cs - C# code demonstrating how to call the web service

* GenProxy.bat - Code to generate the decision service proxy from the WSDL

* App.config - The configuration file for the decision service endpoint

For details, see the following topics:

* Creating WSDL and proxy files

Creating WSDL and proxy files

The WSDL and the proxy files are created as follows:
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1. If your .NET Server and Studio are colocated, you have the Tutorial Ruleflow in the server's
[CORTICON WORK DIR]\Samples\Rule Projects\Tutorial\Tutorial-Done.

If your .NET Server and Studio are on separate machines, copy and stage that file so that it can be accessed
on the .NET server machine.

2. Launch the Deployment Console on the Corticon Server .NET machine by choosing the Start menu command
All Programs > Progress > Corticon 5.7 > Corticon .NET Deployment Console

3. Click the ... button to the right of the Ruleflow on the one empty line listed, and the locate the
tutorial example.erf file.

4. In the lower section, click the Type dropdown, and then choose WSDL.

The window should now look like this:
Figure 13: Creating a new WSDL using the Deployment Console

%1 Progress Corticon Deployment Censole - New Deployment Descriptor EI@
File

Decizion Services Deployment Properties

Decision Service Maximurn
MName Ruleflow Wersion Version Label Effective Date Expiration Date Pool Size Database Access

tutorial_example | 1T utorial-Doneutorial_example.erf | 016 ‘<unavallahle> |<unava|\ab|e> ‘(unavallah\a | 5 |

4 | |

Add Ruleflow Remove Ruleflow Pre-compile Decizion Services Save Deployment File |

Service Contract Specification

Decizsion Service Level (~  Vocabulary Level (&

“Wocabulary File: |C:\jT»Unstall,dirWorkﬁdir\?erver\?amples\qula Praojectz T utorial*T utorial-Done'Cargo.ecore

#ML Messaging Style: |Flat
SOAP Server URL: | http: Mocalkhost88504x1 s

Generate Service Contracts ‘

| Ready

5. Click Generate Service Contracts to save the service contract file, which is named Cargo Cargo.wsdl.
It may be convenient to generate this file into a separate directory. Here, we use directory
[CORTICON WORK DIR].

Note: To generate a web service proxy, you need wsdl .exe. When you run wsdl .exe
Cargo_Cargo.wsdl,thefile CargoDecisionService. csis created. Place thatfile in the NET Server's
[CORTICON HOME]. Refer to the GenProxy.bat file located at [CORTICON HOME \Server
.NET\samples\wcf-client for the WSDL options, typically /namespace: and /out:.

6. Write C# client code to call the web service. We provide a sample in CallCargoService.cs, which sets
values of attributes used in the rules.
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7. Compile CargoDecisionService.cs and CallCargoService.cs usingthe csc *.cs command.
Generally, the compile process needs to occur in your .NET Framework root directory, so you may need to

move both C# files to that directory prior to compilation. In our case, the .NET Framework is installed at
C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319

This generates an executable file named CallCargoService-webservice.exe. Store the file in your
[CORTICON WORK DIR].

8. If you have not already done so, deploy the tutorial example Decision Service to Corticon Server for
.NET on IIS. Follow the instructions for Creating and Installing a Deployment Descriptor File.

9. RunCallCargoService-webservice.exe to execute the call to Corticon Server. You will see the
following output:

Figure 14: Invoking Corticon Server for .NET via C# Sample Code

Calling service tutorial_example

wWorkDocumentsType

Cargo weighing > 20000 kilos and a volume <= 30 cubic meters
must be packaged in a heavyweight container.
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A

Updating your Corticon license JAR for .NET

Progress Corticon embeds an evaluation license in its products to help you get started.
* Corticon Studio evaluation licenses are timed to expire on a preset date.

* Corticon Server evaluation licenses limit the number of decision services, rules, and pools in use. They too
are timed to expire on a preset date.

When you obtain a license file, it applies to Studios as well as Servers. You must perform configuration tasks
to record it for each Corticon Studio, each Corticon Server, and each Deployment Console. Contact Progress
Corticon technical support if you need to acquire a license.

The Corticon Server license is placed at two locations in the installation, one for Corticon Server, and the other
for Corticon Deployment Console

To configure Corticon Server for .NET to access its license file:

1. Copy the license JAR with its default name, CcLicense.jar.

2. Depending on your server strategy, the JAR must be placed in its required locations:
* For an in-process deployment:

1. Navigate to the .NET Server installation's [CORTICON HOME] \samples\1lib directory to paste the
file and overwrite the existing file in that location.

2. Navigate to the .NET Server installation's [CORTICON HOME] \webservice\lib directory to paste
the file and overwrite the existing file in that location.

* Foran IIS deployment:

* Navigate to the IIS installation location, typically C: \ inetpuband then navigate to its
\wwwroot\axis\1lib directory to paste the file and, if necessary, overwrite the existing file in that
location.
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When you launch the Corticon Deployment Console, your license with its registration information is registered
for the Corticon Deployment Console.

Note:

You can choose to locate the license by another JAR name at a preferred location, and then expressly identify
it to the server.

To custom configure Corticon Server for .NET's license location:

1. Navigate in the file system to the Corticon Server for .NET installation's, [CORTICON HOME]\Server
.NET\samples\bin subdirectory.

2. Double-click on Corticon-Api-Inprocess-Test.exe, then do the following:
a. Type 416 and then press Enter.

b. Enter (or copy/paste) the complete path to the location of the license JAR file, as in this example,
C:\licenses\myCorticon CcLicense.jar. The command echoes back Transaction
completed.

c. To confirm the setting, type 415 and then press Enter. The path is echoed back (you might need to
scroll up to the command line.)

3. Once the .NET Server is running in remote mode, you can double-click on
Corticon-Api-Remote-Test.exe in that same directory to perform the same 416 and 415 tasks as in
Step 2 above
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Corticon 5.7.1 Online Tutorials and

Documentation

TUTORIALS: Learn about Corticon from online lessons at the Corticon Learning Center.

DOCUMENTATION: About this release

What's New in Corticon Online Help
PDF

Describes the enhancements and changes to the product since its
last point release.

Corticon Installation Guide Online Help
PDF

Step-by-step procedures for installing Corticon Studio and Servers
in this release on Windows and Linux platforms.

DEVELOPMENT DOCUMENTATION: Define and Model Business Rules

Rule Modeling Guide Online Help PDF

Introduces how business rules are modeled in Corticon Studio
including the creation of Vocabularies, Rulesheets, Ruleflows, and
Ruletests. This is the starting point for new rule modelers.

Quick Reference Guide Online Help
PDF

Reference guide to the Corticon Studio user interface, including
descriptions of all menu options, buttons, and actions.

Rule Language Guide Online Help PDF

Reference information for all operators available in the Corticon Studio
Vocabulary.
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https://www.progress.com/corticon/corticon-learning-center
https://documentation.progress.com/output/Corticon/5.7.1/html/corticon/whats-new-in-corticon.html
https://documentation.progress.com/output/Corticon/5.7.1/pdf/whats_new_corticon.pdf
https://documentation.progress.com/output/Corticon/5.7.1/html/corticon/corticon-installation-guide.html
https://documentation.progress.com/output/Corticon/5.7.1/pdf/corticon_install.pdf
https://documentation.progress.com/output/Corticon/5.7.1/html/corticon/corticon-studio-3a-rule-modeling-guide.html
https://documentation.progress.com/output/Corticon/5.7.1/pdf/corticon_rule_modeling.pdf
https://documentation.progress.com/output/Corticon/5.7.1/html/corticon/corticon-studio-3a-quick-reference-guide.html
https://documentation.progress.com/output/Corticon/5.7.1/pdf/corticon_quick_reference.pdf
https://documentation.progress.com/output/Corticon/5.7.1/html/corticon/corticon-studio-3a-rule-language-guide.html
https://documentation.progress.com/output/Corticon/5.7.1/pdf/corticon_rule_language.pdf

Appendix B: Corticon 5.7.1 Online Tutorials and Documentation

Extensions Guide Online Help PDF

Detailed technical information about the Corticon extension framework
for extended operators and service callouts.

Javadoc for Extensions APl Javadoc

Complete Java API reference for Corticon Extensions.

DEPLOYMENT DOCUMENTATION: Run Decision Services on Servers

Integration and Deployment Guide
Online Help PDF

Provides details on deploying and managing Corticon Decision
Services. Start here to learn about the options for deploying Corticon,
the best practices for managing your deployment, and the APIs for
integrating Corticon with clients executing rules.

Data Integration Guide Online Help
PDF

Provides details on how to integrate Corticon with external data
sources and how to use Corticon for batch rule processing. Includes
details on Corticon EDC and ADC features for accessing data from
Decision Services.

Web Console Guide Online Help PDF

Presents the Corticon Web Console which can be used to manage
your Corticon deployment. This GUI interface simplifies the
management and monitoring of Corticon servers and Decision
Services.

Deploying Web Services with Java
Online Help PDF

Provides details on deploying Corticon as a REST or SOAP web
service on Java application servers.

Deploying Web Services with .NET
Online Help PDF

Provides details on deploying Corticon as a REST or SOAP web
service on Microsoft IIS.

Javadoc for Corticon Server API
Javadoc

Complete Java API reference for Corticon Server.
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https://documentation.progress.com/output/Corticon/5.7.1/html/corticon/corticon-studio-3a-extensions-guide.html
https://documentation.progress.com/output/Corticon/5.7.1/pdf/corticon_extensions.pdf
https://documentation.progress.com/output/Corticon/5.7.1/javadoc/Extensions
https://documentation.progress.com/output/Corticon/5.7.1/html/corticon/corticon-server-3a-integration---deployment-guide.html
https://documentation.progress.com/output/Corticon/5.7.1/pdf/corticon_integration_deployment.pdf
https://documentation.progress.com/output/Corticon/5.7.1/html/corticon/corticon-server-3a-data-integration-guide.html
https://documentation.progress.com/output/Corticon/5.7.1/pdf/corticon_data_integration.pdf
https://documentation.progress.com/output/Corticon/5.7.1/html/corticon/corticon-server-3a-web-console-guide.html
https://documentation.progress.com/output/Corticon/5.7.1/pdf/corticon_web_console.pdf
https://documentation.progress.com/output/Corticon/5.7.1/html/corticon/corticon-server-3a-deploying-web-services-with-jav.html
https://documentation.progress.com/output/Corticon/5.7.1/pdf/corticon_deploying_web_services_with_java.pdf
https://documentation.progress.com/output/Corticon/5.7.1/html/corticon/corticon-server-3a-deploying-web-services-with-.ne.html
https://documentation.progress.com/output/Corticon/5.7.1/pdf/corticon_deploying_web_services_with_dotnet.pdf
https://documentation.progress.com/output/Corticon/5.7.1/javadoc/Server
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